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Notices 

Please return your warranty card to Passport immediately. It 
costs you nothing to do so and your name will be placed on our 
mailing list so that we can inform you of all program updates and 
related developments at Passport. Please return your warranty card 
today. 

This manual is copyrighted. All rights are reserved. No part of this manual 
may be copied, reproduced, translated or reduced to any electronic medium or 
machine readable form without the written consent of Passport Designs, Inc. 

Passport Designs, Inc. makes no warranties either express or implied with 
respect to this manual or with respect to the software described in this manual, its 
quality, performance, merchantability or fitness for any particular purpose. 

Passport Designs, Inc. reserves the right to make improvements or changes 
in the product described in this manual at any time and without notice. All 
specifications are subject to change without notice. 

Master Tracks Jr. was designed by Dave Kusek and Don Williams. 
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Apple IJgs version modified by David Howell 
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PASSPORT SOFTWARE LICENSE 

. ~) Grant of Ljc~nse. In ?onsideration of payment of the license fee, 
which IS a part of the poce you paid for this product, PASSPORT, as licensor, 
~ants to you, the LlCEN?EE, a nonexclusive right to use and display this copy of 

,aste,r Tracks Jr,TM (hereinafter the ~SOFTWARE") on a single COMPUTER C 
with single CPU) at a single location. PASSPORT reserves all rights not expl~:~sry 
granted to LICENSEE. 

2) . Qwne~hiD of Software, As the LICENSEE, you own the ma netic or 
other physIC~[ media on which the SOFTWARE is originally or subSeqUe~tly 
recorded or fixed, ~u.t PA~SPORT retains title and ownership of the SOFTWARE 
recorded on the angmal disk copy and all subsequent copies of the SOFTWARE 
ref!ardJes,s o~ the fo~m or media in or on which the original and other copies may' 
eXISt. ThIS LIcense IS not a sale of the original SOFTWARE Or any copy. 

.3) CopY Rfstrictions. This SOFTWARE and the accompan in written 
~~~s are copynghted. Una~thorized copying of the SOFTWARJ. i~cluding 
the Writt:RE t~at. hla~ been modIfied, merged, or included with other software or of 

n m? en:=t s .IS expressly forbidden. You may be held legally res on~ible 

~~ t~it~~~~~~~~;~f~i~~~:eni-~~:~~~uWsAedREor endcour~ged by your failure to abide 
. pro uct IS copy protected. 

4) Use Restrictions. As the LICENSEE, you may physically transfer the 
SOFTWARE from one com~uter to another, provided that the SOFTWARE is used 
on only one computer at a tIme. You may not electronically transfer the 
SOr:rw:~E ~~m one computer to anoth~r ove~ a network. You may not distribute 
copIes o. t e FfWARE, or accompanYing written materials to others. You ma 
~ot.mo.dlfy, adapt, translate, reverse engineer, decompile, disassemble or creatZ 

envatlve wO.rks.based on the SOFTWARE. You may not mOdify, adapt translate 
or create derivative works based on the written materials without the pribr written 
consent of PASSPORT. 

5) Transfer Restrictions. This SOFTWARE is licensed only to you the 
L~~~~~~EO' and may not b~ transfered to anyone without the prior written ~onsent 
a RT. Any authonzed transferee of the SOFTWARE shall be bound b 
the t~rms and conditions of this Agreement. In no event may you transfer assiJn 
rent, ease, sell. or otherwise dispose of the SOFTWARE on a temporary ~r ' 
permanent baSIS except as expressly provided herein. 

. 6) . Terminati8n. This License is effective until terminated. This License 
WIll terminate automatically without notice from PASSPORT if you fail to comply 
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with any provision of this License. Upon termination you shall destroy the written 
materials and all copies of the SOFTWARE, including modified copies, if any. 

7) Update Policy. Passport may create from time to time, updated 
versions of the SOFTWARE. At its option, PASSPORT will make such updates 
available to the LICENSEE who has paid the update fee and returned the 
Registration Card to PASSPORT. Registered owners of Master Tracks are entitled 
to purchase later revisions of the program for an update fee. Send your current 
program disk{s) along with the update fee directly to Passport DeSigns, Inc. 
Attention: Software Update at the address listed on the back cover. 

8) Miscellaneous. This Agreement is govemed by the laws of the State of 
California. 

PISCLAIMER OF WARRANTY ANP I IMITEQ WARRANTY 

THE SOFTWARE AND ACCOMPANYING WRITTEN MATERIALS 
(INCLUDING INSTRUCTIONS FOR USE) ARE PROVIDED "AS IS" WITHOUT 
WARRANTY OF ANY KIND. FURTHER, PASSPORT DOES NOT WARRANT, 
GUARANTEE OR MAKE ANY REPRESENTATIONS REGARDING THE USE OR 
THE RESULTS OF THE USE, OF THE SOFTWARE OR WRITTEN MATERIALS IN 
TERMS OF CORRECTNESS, ACCURACY, RELIABILITY, CURRENTNESS OR 
OTHERWISE. THE ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE 
OF THE SOFTWARE IS ASSUMED BY YOU. IF THE SOFTWARE OR WRITTEN 
MATERIALS ARE DEFECTIVE YOU, AND NOT PASSPORT OR ITS DEALERS, 
DISTRIBUTORS, AGENTS OR EMPLOYEES, ASSUME THE ENTIRE COST OF 
ALL NECESSARY SERVICING, REPAIR OR CORRECTION. 

Passport warrants to the Original LICENSEE that the disk(s) on which the 
SOFTWARE is recorded is free from defects in materials and workmanship under 
normal use and service for a period of ninety (90) days from the date of delivery as 
evidenced by a copy of the receipt. Further, PASSPORT hereby limits the duration 
of any implied warranty on the disk to the period stated above. Some states do not 
allow limitations on duration of an implied warranty, so the above limitation may not 
apply to you. 

PASSPORT's entire liability and your exclusive remedy as to the disk(s) shall 
be replacement of the disk that does not meet PASSPORT's limited warranty and 
which is returned to PASSPORT with a copy of the receipt or warranty. If a failure 
of the disk has resulted from aCCident, abuse or misapplication, PASSPORT shall 
have no responsibility to replace the disk(s) or refund the purchase price. Any 
replacement disk(s) will be warranted for the remainder of the original warranty 
period or thirty (30) days, whichever is longer. 

Defective media returned by the LICENSEE during the warranty period will 
be replaced without charge, provided the licensee has signed and returned the 
warranty registration card enclosed with the product, and provided that the returned 
product has not been subjected to misuse, damage, or excessive wear. Following 
the initial ninety-day warranty period defective media wi!! be replaced for a 
replacement fee - contact PASSPORT for details. 
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All product returns must be accompanied by a Return 
Authorization Number issued by PASSPORT. Please call PASSPORT 
and request an RA number before returning any product to 
PASSPORT. Returned media should be shipped in a protective 
package (with the RA number on the outside), postage or shipping 
costs prepaid, to Passport Designs at the address listed below, and 
accompanied by a brief description of the problem. 

THE ABOVE ARE THE ONLY WARRANTIES OF ANY KIND, EITHER 
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE, THAT ARE MADE BY PASSPORT ON THIS PASSPORT PRODUCT. 
NO ORAL OR WRIDEN INFORMATION OR ADVICE GIVEN BY PASSPORT, ITS 
DEALERS, DISTRIBUTORS, AGENTS OR EMPLOYEES SHALL CREATE A 
WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF THIS WARRANTY AND 
YOU MAY NOT RELY ON ANY SUCH INFORMATION OR ADVICE. THIS 
WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS. YOU MAY HAVE OTHER 
RIGHTS, WHICH VARY FROM STATE TO STATE. 

NEITHER PASSPORT NOR ANYONE ELSE WHO HAS BEEN INVOLVED IN 
THE CREATION, PRODUCTION OR DELIVERY OF THIS PRODUCT SHALL BE 
LIABLE FOR ANY DIRECT, INDIRECT, CONSEQUENTIAL OR INCIDENTAL 
DAMAGES (INCLUDING DAMAGES FOR LOSS OF BUSINESS PROFITS, 
BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION AND THE 
LIKE) ARISING OUT OF THE USE OF OR INABILITY TO USE SUCH PRODUCT 
EVEN IF PASSPORT HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGES. BECAUSE SOME STATES DO NOT ALLOW THE EXCLUSION OR 
LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, 
THE ABOVE LIMITATION MAY NOT APPLY TO YOU. 
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Welcome to Master Tracks Jr. for the Apple IIgs. Master 
Tracks Jr., from Passport Designs, Inc. is an easy to use and 
versatile 64 track MIDI sequencer for the Apple IIgs. 

Complementing a full line of software products for musicians, 
Master Tracks Jr. represents Passport:s commitment to .. 
offering serious musicians and enthusiasts the composition 
and performance features they want most. 

Master Tracks Jr. gives you a free-form approach to 
composing music. Using as many as 64 separate MIDI tracks, 
you can create, combine or edit musical phrases of any 
length, just as you would use a word 'processor to wnte a 
document. You can enter these musical phrases Into the 64 
track MIDI recorder either by simply playing your MIDI . 
equipped instrument in real or step time: Then you can eaSily 
edit, rearrange and combine the tracks In. a vanety ?f ways to 
build complete songs. The program provides real-time and 
step-time input, song editing, and many powerful editing 
features all in one package. 
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features Master Tracks Jr. includes features which let you do the 

following: 

Control th~ sequencer using an on-Screen control panel 
that looks like a tape recorder transport control. Use the 
mou~e and IIgs keyboard to Play, Record Pause Stop 
ReWind or Fast-Forward. '" 

Set the meter, tempo and beat independently for each 
measure. 

Display the elapsed time of any section of your piece. 

Record all MIDI events on the 16 possible MIDI 
channels Simultaneously, including key velocity, 
after-touch, sustain, modulation and pitch wheel 
changes and progrann changes. 

Apply automatic and musically accurate error correction 
to your mUSIC, compensating for imperfect playing 
technique. 

Merge, delete, transpose, repeat and copy individual 
tracks, or selected portions of tracks. 

Change the note velocities, note durations key tem a 
or meter for whole tracks or just selected regions of ~ , 
track or tracks. 

Change playback tempo instantly or gradually over time. 

Set markers anywhere in a piece and easily jump to 
those locations for easy editing. An auto-rewind feature 
can be set to qUickly "rewind" your composition to a 
g.,ven pOint for effortless recording of multiple takes of a 
Single track, or of subsequent tracks. 

You can set Master Tracks Jr. to scroll the graphic 
display ot.your sequence as it plays it, so you can See 
your locatIon on screen as you listen. 

You can incorporate your MIDI music into professional 
audiO and video productions utilizing MIDI Song Pointer 
and external SMPTE synchronizers. 

Chapter I-Introduction /-3 
Master Tracks Jr. is similar to a fancy tape recorder, only much 
more capable. Like a multi-track tape machine, Master Tracks 
Jr. lets you record one track of music at a time, playing them 
back later as an ensemble. You can even edit each track 
individually to make changes or fix mistakes - a feat which is 
impossible with audio tape recorders. And with a total of 64 
tracks available at any given time, Master Tracks Jr. offers 
much greater flexibility than do most tape machines. 

As you may know, there are many MIDI sequencers available 
today. So, what makes Master Tracks Jr. different? To begin 
with, Master Tracks uses dynamically allocated tracks. This 
means that the various tracks in a given musical piece can be of 
any length, and that length is alterable. Many other sequencers 
require all tracks to be the same length. Master Track Jr. does 
not. 

Secondly, Master Track Jr. allows you to alter discrete portions 
of a track or tracks after you've made a recording. This is similar 
to the ability to mark and alter blocks of text when using a word 
processor. Regional selections are made in the same way with 
Master Tracks Jr.. This type of editing is similar to many 
" Macintosh" oriented programs. After marking a block of music 
in Master Tracks Jr., you can then modify the selected section in 
a wide variety of ways. 

You record your musical sequences, one track at a time, either 
in real time (as you play on a MIDI-equipped keyboard), or note 
by note with your midi keyboard (step entry). For step entry of 
notes, Master Tracks Jr. provides a special Step Edit screen 
that clearly shows your location in the sequence and allows you 
to easily choose note durations, erase mistakes and enter 
rests. 

Tracks can be mixed together with other tracks in a variety of 
ways to form compositions of various lengths - even very long 
pieces. Using the Master Tracks Jr.'s clipboard, you can cut and 
paste sections of one piece into another piece to quickly create 
songs based on a number of existing sequences. 

Because of its' intuitive user interface, Master Tracks Jr. is a 
program that is easy and fun to use. 
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how it works 

switching 
between 
windows 

Master Tracks Jr.'s many program functions and commands 
are organized logically into a number of different windows 
where you work with your sequences. There are four main 
windows: 

~ Transport window - where you control your MIDI tape 
deck by clicking on Play, Stop, Fast-Forward, etc. 

~ Sequencer window - where you you record and 
playback your tracks. 

~ Conductor window - where you control tempo, meter 
and beat settings. 

~ Song Editor window - where you display, cut, copy, 
paste, and regionally alter tracks. The structure of a 
sequence is displayed and edited in units of measures. 

All of the windows and their associated commands are 
accessed via the menu bar at the top of the IIgs's screen, You 
simply point to the name of the window or command you want, 
press the mouse button and pull the mouse toward you. Then 
highlight the selection you want from the menu, release the 
button, and the program does the rest. 

Master Track Jr. lets you have several windows "open" and on 
the screen at the same time. However, at any given time, there 
is only one active window. The active window is the one you 
are working on at the time. To activate a different window you 
simply pOint to it and click the mouse. Additionally, you can 
move windows around to convenient locations on the screen 
and size them according to your preferences. 

Once you have the windows set up the way you like, you can 
then easily switch between them. It's a little like setting up your 
desktop or work area to have everything in a convenient 
location. A setup we've found useful lines up the Song Editor 
and Sequencer windows so that tracks line up. The transport 
control sits at the bottom of the screen, as you see in Figure 
1.1, as does the conductor window. 

figure 1.1 

using 
command 

keys 
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The window's menu items all have IIgs keyboand e~ivalents, 
too The three main Master Tracks Jr. wmdows can e 
accessed by pressing Command-I, 2, or 3. 

Aside from the menu and window selection techniques t t 
described above, there arle some s~~~;~~t:.';i:a~;k~at~ 0 
use IIgs programs often et you us d C t 

eriorm certain operations, such as Co~y, Paste, an u 
~ather than using the menu selections directly. 

the Command key and the 
To use theJe c~~yma~~~~'l~~f;i~~. Sometimes this is the first 
correspon mg d Having two ways to select and execute 

~~~~~~~; ~~~w~~lexibilityfor indivi~ual Rref1h~n;'~~~~~hile 
situations. You may find that y~u n~ai~~~I~~n get things done 
you are lear~~~ i~~~~~da~ys uonce you're more familiar with 
faster uSing r nS about this or other Apple 

lr;sp;~~~~i~s,I~~~~u~f~~ ~us~~,~o guide supplied dithnyg~~~P:r 
(see the Summary of MT Jr. keyboard cornman s I 
11 ) 

Now proceed to Chapter 2 to connect up your hardware and 
install your program. 
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Before you begin using Master Tracks Jr., you will have to: 

.. Insure that your Ilgs has a minimum of 76aK total memory . 

.. Hook up your MIDI inteTiace to your IIgs . 

.. Connect your MIDI cables between your synthesizer and 
computer . 

.. Make a working copy of the Master Tracks Jr. disk or install 
the software onto your hard disk (if you are using one). 

This chapter explains how to do these procedures. Please take 
the time to read this chapter so that you can begin using Master 
Tracks Jr. quickly and without any unnecessary headaches. 

"Soflware Master Tracks Jr. allows you to make a back-up copy of the 
Inslal/alion program for your use only. Copying software and giving it 

away or selling it is illegal. Copy protection is one method 
that we could use to protect our legal rights. Other even more 
unpleasant methods can be employed when necessary. How­
ever, we feel these methods are cumbersome for both the man­
ufacturer and the user. We ask you to respect our copyrights 
and to help ensure future updates and improvements to the 
program by not copying our software. 
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Backup disks If you NEVER store any data files on your program disk it should 
last you qUite a long time. Replacement backups can be 
purchased from Passport. 

customer The Master Tracks Jr. system consists of several highly complex 
support and constantly evolving programs. It is very likely that, at some 

pOint In tlm7, you will need a program update or some other 
form of assistance. For this reason n is vitally important that you 
return your warranty registration card and become a registered 
own~r. Only r~QI~tered owners will be eligible for customer 
~ Sending. In your warranty card also places you on our 
g~~abase to receive new product and update announcements. 

floppy disk 
installation 

Send in your warranty registration card today! 

Also, you should have both your original disks and your 
manuals handy when calling In for customer service. Our 
personnel may ask you a few simple questions to verify that you 
are an authonzed user. 

Keep your original disks in a safe place! 

You can playa part in the evolution of Master Tracks Jr We are 
extrem~ly interested in your feedback on the program and your 
suggestions for future enhancements. The current version of 
Master Tracks Jr. IS the result of suggestions and comments 
from hundreds of users just like you. Let us know what you want 
to see next and we will try and implement your ideas. 

Remember, you have not just purchased a disk and printed 
pages, you have Invested In the expertise of all the people 
Involved In the entire Master Tracks Jr. project. Thank you for 
your support. 

To make a ba~kup copy of the program on a floppy disk, copy 
the. program disk onto a blank disk using the finder or a copy 
utility. Use thiS backup as your working disk and keep the 
anginal program disk to use as a archival copy. 

hard disk 
instal/ation 

modifying your 
system folder 

I>Hardware 
Requirements 

I>Hardware 
InstaJ/ation 

hooking 
up your 

MIDI 
cables 
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To install the program onto a SCSI ("scuzzy") hard disk, 
simply boot your system off the hard disk to enter the Finder. 
Next, insert the original program disk into the IIgs and 
double-click on the disk icon to open the active window. Now 
drag the Master Tracks Jr. icon onto your hard disk window. 
Master Tracks Jr. will then be copied onto your hard disk. 

Next, open the ICONS folder on your MT Jr. disk and copy the 
Icon called JRIIGS.lCONS into your ICONS folder on your 
Hard Disk. Master Tracks Jr. is now ready to be run from your 
Hard Disk. 

If you are using a system other than the one provided with 
your Master Tracks Jr. disk, you must insure that you have the 
correct MIDI device drivers installed. You must have a 
DRIVERS folder included in the SYSTEM folder of your 
startup disk (either floppy or hard disk). There are two files 
which must be present in your DRIVERS folder before MT Jr. 
will run properly. 
These files are named APPLE.MIDI and CARD6850.MIDI. 
You will find these files included in the Drivers folder of your 
System folder which is included on your Master Tracks Jr. 
disk. Copy these files in the same manner that you copied the 
JRIIGS.lCONS file into your ICONS folder. 

Master Tracks Jr. requires a standard 512K Apple IIgs with a 
minimum extra 256K of memory. For optimum performance, 
we recommend that you have 1 Meg total memory. MT Jr. 
also requires that you have the IIgs system ROM ver.B 
installed in your IIgs motherboard. Consult your Apple dealer 
for details. 

Master Tracks Jr. works with all 1 MHz passive MIDI interfaces 
(such as those from Passport). Master Tracks Jr. is also 
compatible with the standard Apple II interface. Simply install 
your interface following the instructions that are supplied with 
it. 

The next step is to hook up your MIDI cables. The exact 
configuration of cables will vary depending on your particular 
arsenal of equipment. However, two general schemes are 
shown in Figure 2.1. You will need at least two cables-one 
for MIDI-In and one for MIDI-Out. The first cable goes from 



2-4 Master Tracks Jr. 

starting up 
Master 
Tracks 

Jr. 

MIDI-Out on your synthesizer or keyboard controller to the 
MIDI-In connector on the MIDI interface connected to your 
IIgs. The second one goes from MIDI-Out on the interface to 
MIDI-In on your synthesizer. 

You may want to hook up other MIDI cables too, if you have 
additional synthesizers and sound modules. Some interfaces 
have additional sockets for such connections. Altemately, you 
may chain together a number of synthesizers via any 
MIDI-Thru connectors which your synthesizers have. To do 
this, you simply run a cable from your main synthesizer's 
MIDI-Thru socket to the second synthesizer's MIDI-In 
socket, and so on. Refer to the illustrations on page 2-5 if you 
are in doubt about cable hookups. 

To start up Master Tracks Jr., follow these instructions: 

1. Turn on your MIDI equipment, then your computer in 
the normal manner. 

2. If you are running the program from a floppy disk, make 
sure you insert your Master Tracks Jr. working disk. 

3. Double-click on the JRIIGS icon .. 

This will load the program and display the Sequencer window, 
Song Edit window, Transport control, Conductor and Menu 
bar. You're ready to go! 

Now move ahead to Chapter 3 to quickly learn how to record 
and playa tune with Master Tracks Jr. 

tl:J
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cable hookup 
for self 

contained 
synthesizers 

coble hookups 
for systems 

with controller 
keyboards 

and outboard 
sound modules 
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Interl'oce-~)lu[jS into either Serial Port 

To Ii 

MIDI IntEllj"ce (Plugs into serial port) 

liN 



booting up 

This Chapter walks you through the basics of recording, 
editing and playing back a tune using Master Tracks Jr .. Only 
the basics are described here, but it's enough to get you 
going. We certainly recommend your reading the rest of this 
manual to take advantage 01 the full capabilities of the 
program. 

1. Begin by making sure your MIDI interlace and cables 
are installed properly (see the section on Installation), 
and then turn on your MIDI instrument. 

2. Turn on your Apple IIgs, put your Master Tracks Jr. disk 
. in a disk drive, and wait until the system boots and the 

Finder window appears on the screen. 

3. Double click on the JRIIGS icon in the window to start 
the program.The Master Tracks Jr. main screen will 
appear, with the Transport, Sequencer, Song Editor 
and Conductor windows on the screen as you see in 
Figure 3.1. 

4. Look at the Transport window at the bottom of the 
screen. This window contains the controls you use for 
starting, stopping, fast forwarding and rewinding. It also 
has a pair of counters to show you where you are in the 
sequence, and a number 01 other controls on the right 
side of the window. 

5. Notice that the Auto control is highlighted in inverse 
video, indicating that it is on. When Auto is on, the 
sequence automatically rewinds to its start point as 
soon as you stop playing or recording. 
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6. Notice the Sequencer window at the upper portion of 
your screen. Click on the Record box (the one labeled 
Rec) in the first track of the sequence. Be sure that a 
solid circle appears in the field, indicating that the track 
is activated and is ready to record. 

7. Get your MIDI instrument ready to record your first 
track, and set it to send and receive on MIDI channel 1. 
Start the recorder by Clicking on Record in the 
Transport window, or by pressing Enter on the Apple 
IIgs keyboard. Because of the way the IIgs handles 
incoming data, do not move the mouse while you are 

. recording. This may cause the loss of some of your 
MIDI data. 

8. Play your music. When you're finished playing, hit the 
spacebar. 

Notice that the counter immediately returns to measure 1, 
beat 1 as soon as you stop the sequence, because Auto" 
(auto-return) is on. Notice also that in the Sequencer window, 
the Play box for the track you've just recorded now contains a 
solid black triangle, meaning that it has been activated for 
playback. 

1. To play back your first tr.ack, click on the Record box 
again to deactivate the track for recording, setting it to 
Play mode. 

3.2 

recording 
a second 

track 

playing both 
tracks 
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2. Click on Play in the Transport window, or press the 
spacebar on the Ilgs keyboard (see Figure 3.2). 

3. To stop playback, press the spacebar again. 

1 To record another track, go back to the Sequencer 
. window and activate the second track for r~cordlng by 
clicking in its Record field. You'll see the solid circle 
appear in the field. 

2 The rest of the process is identical to the steps you used 
. to record your first track: just click on Record or press 
the Enter key to start the recorder. You:1I hear your first 
track play while you record. When you re through, 
press the spacebar to stop the recorder. 

By now, it's probably obvious what you have to do to play, both 
tracks of your two-track recording. Simply click on track.2 s 
Record box to deactivate it, and start the playback by clicking 
on Play or hitting the spacebar. 
Master Tracks Jr. lets you give ea~~ trac~ ~ nam~, f?,r easy 
reference. Typical names might be Bass, Horns, Lead 
licks", etc. 
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naming your 
tracks 1. To name your first track, click overthe track name field 

for the track. A small window pops up, as you see in 
Figure 3.3, and you can now type in the name you've 
chosen. When you're through, click on OK or press 
Return. 

" Edit 

figure 3,31 ~~~~~~e~~~~~~~~~~ 
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Master Tracks Jr. works like many other Apple IIgs programs 
when it comes to saving your work on disk. When you're 
ready to save: 

1. Choose Save as ... from the File menu. 

2. As soon as you choose the Save as ... command, Master 
Tracks Jr. will pop up a dialog box that lets you name 
your sequence. You may also select a different Drive or 
Eject the current disk. Since there is very little space left 
on your MT Jr. program disk, Eject it and insert a data 
disk or blank disk. Now type in the name you've chosen, 
and click on OK or press Return. The file will be saved. 
(After you've saved a file once, you won't need to enter 
the name again-it will be saved automatically every 
time you choose the Save command.) 

editing 
your 

sequence 

figure 
3.4 
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Now that you have saved your first sequence, O~e~ th~ file 
on your Master Tracks Jr. original disk entitled J. . f ac 
Invention #1. You can make changes on groups a 
measures from the Song Editor Window. 

1 Choose Song Editor from the Windows menu to call up 
. the window. A graphic representalion of the sequence 
will appear in the window, with each track vIsible as a 
row of rectangular boxes. 
Each box represents a measure. If the measure 

contains any MIDI data, it will appear as a sol~,d black" 
box If it is entirely empty, the box Will appear hollow, 
in o~tline. Both are shown in Figure 3.4. 
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Let's say your sequence has a standard A-B-A pattern and 
you want to use the edit commands to repeat the B se~tion. 

2. First, copy the B section to the Master Tracks Jr. 
clipboard, a temporary holding area for MIDI data 
dUring the editing process. Click on the first measure in 
the B section in Track 1 and drag the mouse diagonally 
(with button still down) across both tracks until the 
entire B section is highlighted, as in Figure 3.5. This 
selects that range of measures. 

3. When all the measures in the B section are selected 
choose Copy from the Edit menu. During the brief ' 
pause, Master Tracks Jr. copies the selected measures 
to the clipboard . 

4. Next we need to insert some new measures in the 
se9uence to make room for the repeat of the B section . 
Click on the space in Track 1 between the last measure 
of the B section and the first measure of the second A 
section. You'll see a blinking vertical cursor appear at 
this insert point. ~'l: .•. I· .. · .. •·•.· •.. !i' . . . . . 
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Goodies 

Insert Measure 

Insert §:J meosure(s) before meosure 15. 

@>RII tracks 

o Only on track [!:] 

5. Now choose Insert Measures from the Edit menu. 
When the dialog box pops up, as in Figure 3.6, type in 
the number of measures that the B section contains. 
Click on OK or press Return when you've made your 
entry, and notice that new empty measures Will appear 
in your sequence as hollow boxes. 

~D Song Editor E!l I 
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6. Now you're ready to add the B section data into these 
new measures. Without changing the Insert pOint, 
choose Paste from the Edit menu . 
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The entire contents of the clipboard will be emptied into the 
new empty measures in both tracks of your sequence 
and you've just created a repeat of the 8 section. ' 

7. You can now click on the Play button or press the 
space bar to hear your revised sequence. 

the transport 
and conductor 

windows 

Master Tracks Jr. is designed to work much like a convention­
al multi-track tape deck. Although a sequence is stored in the 
Apple Ilgs's memory instead of on tape, you still need con­
trols that let you play, record, fast forward, rewind, and stop 
the sequence. You also need a counter to tell you where you 
are in the sequence. The Transport window is where Master 
Tracks Jr. provides these features. 

IID~ Conductor ij InllenUon 1 

The center portion of the Transport window has six screen 
"buttons"- play, record, fast forward, rewind, pause and 
stop. They function just as their counterparts on an actual 
tape deck. To "press" one of these buttons, you just click on it 
with the mouse. You can also execute the play, record, and 
stop functions from the Apple IIgs keyboard. 
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play 

record 

reWind 

fast forward 

stop 

Here's how each of these transport functions works: 

Plays the sequence beginning at the point currently indicated 
in the counter. Pressing the spacebar on the JIgs keyboard also starts playback. Before starting playback, remember to 
be sure that the MIDI channels set for each track agree with the instrument(s) that you are using to play the track. Also, the 
track or tracks you want to hear must be selected (see selecting which tracks play on page 4-6 ). 

Click on the Record button to start recording on the track 
?elected on the Sequencer window, beginning at the location 
In the sequence indicated in the Measure Counter. Pressing the Enter key on the IIgs keyboard also starts the recording. 
To optImIze the performance of MT Jr. when recording, we recommend that you do not move the mouse while you are in 
Record. (See chap. 11, pg. 11-6 on "using the mouse") 
A track must be selected before you start recording, or the command will not function. See selecting which tracks record 
on page 4-6 for details. 

Each time you record on a track, the new data is recorded over any data previously recorded. You can have Master 
Tr~c~s Jr. sta.rt recording at any point in the sequence, and 
e~lstl~g data In the track before that point is left intact. 
Llke~lse, any data in the. remainder of the track past the point at which you stop recording remains untouched. 

Click on rewind to rewind the sequence a measure at a time. You can also move instantly to the beginning of the sequence 
by double clicking on this control. 

Click on the fast forward control to advance through the 
sequence a measure at a time. Double click to move instantly 
to the end of the sequence. 

As you'd expect, clicking on the Stop button stops playback and recording. If the Auto function is on the sequence 
automatically rewinds to wherever you iast started playback. 
You can also use the spacebar on the IIgs keyboard to stop the sequence during playback or recording. 

01/ notes off Pressing the spacebar, or clicking Stop sends an "all notes off" command to all MIDI channels. ' 

pause CI~cking ~n the Pause button pauses both play and record. Chck agam and the sequence resumes playing or recording. 
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M~:asur~ B~:a1 Clock 
I: 1:000 

E1:aps~d Tim~ 
000:00;0 

On the left side of the Transport window are two counters that 
let you locate your current pOSition in the seque~c:e. ~he 
Measure Counter at the top left disl?la}:,s, the pOSltlO~ In the sequence in measures, beats, and l,n~lvldual clock ticks, (Master Tracks Jr.'s internal clock diVides a quarter n~te Into 48 parts (2ticks]). See the section on the Conductor Window 
for more Information about sequence timing). 

You can move to any location in the sequence directly by 
clicking on the measure, beat or clock field in the Measure 
Counter, and typing in the number from the Ilgs keyboard. 

The Elapsed Time Counter shows the actual time (i~ minutes, 
seconds, and tenths of seconds) that has elapsed Since th~ 
begining of the sequence. With AUTO OFF, the Elapsed Time 
Indicator will indicate the time from the beglnmng of the piece 
when you click at any location in an active window or use it's 
scroll bar. The Elapsed Time IndiCCl;tor can be reset ,to zero at 
any time by clicking ,directly in it: ThiS ~Iows you to time any 
section from any pOint even while playing. 

As you'd expect, Rlayi.ng the same sequence at. different 
tempos will result In different elapsed time readlr'9s. Th~ 
Elapsed Time Counter come? in handy for sy~clng mUSIC to video segments or commercials of,predetermlned.length. 
At the right side of the Transport Window are a variety of 
miscellaneous controls: 
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wait for MIDI 

keypress 

auto 

count in 

metronome 

MIDlthru 

Punch In/Out 

~ Key Clicking on the Key control highlights the control. 
Now when you select play or record Master Tracks Jr, 
will wait until it detects that a MIDI key has been 
pressed and released before it begins recording or 
playing. 

~ Auto Turn on Auto by clicking on it. When Auto is on, 
whenever you stop the sequence it will automatically 
"rewind" to the point where playback started last. 

,... Count In When this control is on, Master Tracks Jr.'s 
metronome counts off one measure according to the 
meter set in the Conductor window before starting to 
play or record. 

~ Metronome Clicking on Metronome highlights the 
control, and turns the metronome on. Now, when you 
play or record a sequence, you'll hear a click tone on 
~ach beat of each measure: over the Apple Ilgs's 
Internal speaker for the entire length of the piece. 

.,. MIDI Thru This control is used when you're recording 
from a master MIDI controller, that doesn't produce 
sound itself, or when you want to use one synthesizer 
to control another while recording. Click on MIDI Thru 
to highlight it. With MIDI Thru on, the MIDI data you 
send to the Apple Ilgs will be passed out the MIDI Out 
port on your IIgs's MIDI interface. All the data will be 
sent out on the MIDI channel indicated in the MIDI Thru 
box. If no channel is assigned ("0"), all data will pass 
thru on ii's incoming channel(s). The Thru channel 
follows the channel set for any track set to Record in 
the Sequencer Window. For the best resulis when 
using Thru, do not move the mouse while Thru is 
enabled. (See chap.11, pg. 11-6 on "using the mouse") 

~ Punch Click the Punch button to activate the Punch 
In/Out record mode. There are two ways to select the 
Punch region. Double click the Punch button and a 
dialo~ box appears, letting you type in the In and Out 
locations. The second way to select a region is to use 
the mouse in the Song window and then "OK" your 
selection from the dialog box. Any area selected for 
editing will be the Punch region. You may start the 
transport fr~m any paint by clicking Record or pressing 
Enter or uSing your MIDI keyboard. Recording will start 
and end automatically for the selected region. 
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Punch settings 

Bar Beat Clock 

Inat DEJ~ 
Outot DEJ~ 

OK ( cancel) 

The Sequencer window is the display window fo~ some of the 
most basic information about your sequence. It hsts the 64 
tracks available in Master Tracks Jr., and allows you to select 
the tracks that will record or play. You can also select a MIDI 
channel for all data in each track, choose a nam~ and an 
initial MIDI program number for the track, solo Single tracks, 
and loop tracks independently. 

If the Sequencer window is not already <?n yotfr screen, <?r if .it 
is hidden by other windows, you can ~ctlvate It by choosmg It 
from the Windows menu, or by presSing Command-1 on the 
Apple Ilgs keyboard. 

Sequencer window basics are simple .. To change any item in 
the window, just click in the box of the Item you v..:ant t? 
change. For settings ~hat. are eithe:r on or off, al"! Icon m the 
box indicates the setting IS on, while an empty ~Ield means 
that the setting is off. For parameters that.requlre you to enter 
text or numeric values, a Change Value Window wlll pop up, 
allowing you to enter the information. 

A "0" in the channel or program columns indicates that the 
function is Q.EE for that track. 
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selecting 

wh7t:h 
tracks 

play 

You can select any combination of tracks in your sequence to 
play back. Other tracks that are not selected will not play, 
even if they contain MIDI data. 

selecting 
which 
tracks 

record 

Click in the Play box of each of the tracks that you want to 
select for playback. The triangular play icon'" appears in 
each track's Play box to show that the track is selected, and 
will be played when you start the sequence. In addition 
immediately after you complete a recording on a track, that 
track is automatically set to playback. 

To turn playoff for that track, click in the box again. The play 
icon will become hollow, and the track will not be played when 
you start the sequence. 

Only one track can be selected for recording at a time. To 
select a track for recording, click in the Record box for that 
track. A solid circle appears in the Record box to indicate that 
the track is selected. When you start the recording, all 
incoming MIDI data will be recorded on that track. 

To deactivate a track for recording without selecting another 
track, just click on the Record column for that track again. The 
record icon disappears. 

soloing The Solo command gives you an easy way to play back a 
tracks Single track or a few tracks without having to individually 

deactivate the play box on all the other tracks. Then, when 
you want to hear more tracks again, you only have to turn off 
Solo on the selected tracks. 

naming tracks 

To select a track for soloing, just click on the track's Solo box. 
You'll see a solid black diamond pop up in the box. To turn 
solo off, just click on the box again. Any number of tracks can 
be soloed at a time. 

Each track can have a name, which serves as a memo you 
can use to describe the music in the track or to remind 
yourself of which instrument and/or sound you've chosen to 
play the track. These track names are saved permanently 
with the sequence file when you store it on a disk. 

Click on the Name box in the track you wish to name (you Can 
name any track, even jf it does not contain MIDI data). A 
dialog box pops up and asks you to type in the name of the 
track. You can use any combination of characters you wish. 

selecting 
the MIDI 

playback 
channel 

setting 
the 

program 
number 
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. d r koOK or press Return to com-

When you're fims8e ii;~~n Cancel if you want to return to the 
plete your entryd' r ;'ithout making any changes. Sequencer wm ow 

. t MIDI channel setting The Channel box contams the currTsn feature you need a little 
for playback of the track·hTo user~m handles MIDI channel 
background on the way t e prog 
information. 

rt If pie channel tracks. You can 
Master Tracks Jr. sbl!PPr S ~6~an~els within a track, and you 
record on any com lOa Ion t ck to another retaining all the can freely mix data from one ra , 
original channel data. 

f 1 16 in the Channel box, all If you enter a cha~nel number 0 n that channel. On the other. 
data in the track Will be ~Igy~d a back the track exactly as it IS 
hand, a channel value 0 pays hannel(s) it was received on. stored in memory, on the same c 

r k' th Channel box A small data To change the ,?hannel, c i In in ~he number of the channel 
entry window Will pop up. YP~he arrow controls to the 
you want for the track, or u

l 
se b·s click 

setting. When the cha~ne num er I wlino'Jw. 
press Return to enter It and return to 
Of course you can click on Cancel to 
was. Thru' follows the channel for any track 

f MIDI device's programmed 
A program is ~he MIDI term o~ tl,e device. On a synthesizer, a 
setup, stored 10 the memo~r 0 h" or sound On a drum 
progr~m is equivalent to as~I~~ a particula; song, a~d on.a 
machine, a prog~a~ may I nfiguration setting With 
MIDI effects deVice It mar se ~~~~ ~~rameters on the device. 
pre-programmed values or a when a MIDI program 
Each program ha~ a nU~t~~~ead~Vice the device responds change message IS sen , 
by switching to that program number. 

. th mber in the Program field 
On the Sequencer wmdow, e n~ that Master Tracks Jr. will 
refers only to the programbnur:nbeplaYing from the beginning. send when the sequence eglns 

. . 0 (th default) no program change is 
If the program settmg IS b .e s---your'instrument will remain 
sent when the sequence it'~~Deady on until it receives a 
set to whathever Pfrog~at~e sequence data. Likewise, if you program c ange ro 
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Fill 

start the sequence from some pOint other than the very beginning, the program indicated in the Program field is not sent, and only program changes stored in the sequence data will be sent, 

To change the program setting, click on the Program field for the track you want, When the small data entry window pops up, type In the number of the program you wish, or click on the arrow keys to raise or lower the value. When the number 
is correct, click on OK or press Return to enter it and return to the Sequencer window, or click on Cancel to return without entering the change. The program change will be sent out 
whenever you click OK or press Return even when a sequence is playing. 

looping Each track in a Master Tracks Jr. sequence can be a track independently looped, When the sequence gets to the end of a track, It plays the track over again from the beginning, no matter what other tracks are doing. 

playing 
a sequence 

Since the Record function always rounds recorded tracks to the nearest complete measure, the track always plays to the end of a measure before looping back, even if no notes are playing in the measure. 

Another important detail is that looping only works if you start playback before any of the tracks in the sequence have 
ended, If you have a short track and start playback in the 
middle of the song, after that track has ended, the looped track won't play, 

To set a track to loop, Simply click in the loop box for the 
trac~, at the f~r fight of the Sequencer window: The Loop icon 
.tl will appear In the box. To shut the loop function off, click on the loop box again, and the icon disappears, 

To playa sequence, first be sure to select the tracks you want to play, and check that the MIDI channels agree on your MIDI deVIces with the data In the sequence. If you wish, use the transport controls to move the Measure Counter to the point in the sequence where you want to begin playback. 

recording 
a track 

Chapter 4- Basic Sequencer operation 
You can start playback in one of two ways: 

.... click on the Play button in the Transport window. 

I>- press the spacebar on the IIgs keyboard, 

4-9 

Once you start the play function wi~h one of !hese controls, the sequence will immediately begrn to play If the KeYda~~ Count In settings on the Transport wmdow are off, an I ync 
is set to internal with the MIDI setup command on theJ '11 Goodies menu. If Key is on, howev~~, Master Tracks r. WI pause before beginning to play until It detects that a ,MIDI key 
has been played and released, If Count In IS on, you :: get' a one measure count~in, and then play wI~1 be~m. Fma. y, I Sync is set to MIDI, Master Tracks Jr, will walt to begin 
playback until it receives a Start command from the external 
MIDI sync source. 

During playback, you can change sequence tempo with the 
left and right arrow keys .. 

To record a track, first select it for recordi.ng by c1i~king in the 
Sequencer window Record box as described earlter. 

The program can record on al116 MIDI channels simu.ltane~ 
ously If you wish however you can use the Record FIlter on the G'ood'les men'u to select a particular channel before you start recording (check Chapter 10 for details on the Record 
Filter), 

If au do select a channel on the Record Filter, Mas~er. Tracks Jr: will only record the data from that channe:l, and Wllllg,nore 
any data it receives on other channels. In thIS case, you II need to be sure that your synthesizer is set to send on the 
same channel before you start to record. 

Master Tracks Jr, can record all types of MIDI data, but you, can also use the Record Filter to filter out any types you don t want to record. Again, check Chapter 10 for more detaIls. 

Start recording with one of these two options: 

.,.. Click on the Record button on the Transport window 

I>- Press the Enter key on the Apple IIgs keyboard, 
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the 
conductor 

window 

At this point, if the Key and Count In controls on the Transport 
window are off, and if Sync is set to Internal with the MIDI 
Setup command, Master Tracks Jr. will immediately begin to 
record. R.emember, for the,best results, do not move the 
mouse while you are recording. 

On the other hand, if Key is on, the program will wait until it 
detects that a MIDI ke¥ has been pressed and released 
before It begms recordmg. If Count-in is on, you'll get a 
one*measure count-In (you can hear it if the metronome is 
on), and then the recorder starts. If sync is set to MIDI 
Master Tracks Jr. Will pause until it receives the signal 'to start 
from an external MIDI device. 

When you've finished recording, hit the spacebar on the IIgs 
keyboard. 

As soon,as you ~ave finished recording a track, the program 
automatically activates the track for playback, and the play 
Icon appears In the track's Play box. 

It's a good ide? to get in the habit of deactivating a track's 
recor,d mo~e nght after you've recorded it so you don't record 
~ver It accidentally ~ext time. Click on the track's Record box 
In the Sequenc~r Window, so that the circle disappears from 
the box, protecting the track. 

Conductor 
Tempo = 120 

f¢l'"""",,,,1 ,,,,,,,,,,,,, 191 

~ J=120 

The Conduc~or wind?w i~ a ?maU but very important Master 
!racks J.r. Window, since It displays sequence timing 
Information. On the Conductor Window, you'll see the current 
value:s for the tempo, the beat, and the meter, as set on a 
speCial Master Tracks ~r. track called the Conductor track. If 
the ~onductor ~mdow IS not on the screen, or if it is hidden 
behind other Windows, you can make it visible by choosing 
Conductor on the Windows menu. 

changing 
the 

tempo 

the 
conductor 

track 
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You can use the tempo scroll bar in the Conductor window to 
change the tempo, even while a sequence is playing. There 
are three ways to do this: 

~ You can click and hold on the scroll box in the scroll bar, 
and drag it directly to a new value. 

~ Clicking anywhere in the grey part of the scroll bar 
moves the scroll box rapidly toward that location, and 
causes a corresponding rapid change in the tempo 
setting. 

~ Finally you can click and hold over one of the arrow 
controls at either end of the scroll bar. This changes the 
tempo value one value at a time. 

Because adusting the tempo requires using the mouse, It is 
important to remember that you can change the tempo only 
when there is no incoming MIDI data 

The Conductor track is a separate track in a Master Tracks Jr. 
sequence that determines timing for the entire sequence. 
The Conductor track allows each measure to have its own 
meter, tempo, and beat note, and the tempo can change 
gradually, even within a single measure. 

You can think of tempo changes you make with the scroll bar 
in the Conductor window as offsets to the actual tempo valUe 
stored in the Conductor track. The play tempo in the 
Conductor window automatically follows the changes in the 
Conductor track tempo. When you change the play tempo 
using the Conductor window scroll bar, all the original tempo 
changes in the Conductor track are preserved, but during 
playback, they are scaled proportionally to the change you 
make. When you click in an active window with Auto Off, the 
elapsed time setting is calculated based on the actual 
Conductor track, not the playback offset. Once you settle on 
a tempo you like, it is a good idea to use the Conductor dialog 
from the change dialog to adjust the actual Conductor track 
tempo. If you have tempo changes in your sequence, this 
adjustment should be made using the percentage box to 
preserve the tempo changes. 
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~~ enter new C~nductor track settings for the entire 

~~~f~~~?~~~~~!~J~~gl~t~~!{!~~~i~~1Jl~~~ the 
ond~ctor ... on the Change menu. See the section On 

changrng Conductor values in Chapter 8 for details. 

song 
editor 

window 

The Song Editor allows you to edit large blocks of music at 
one time. Working on groups of measures, you can move 
sections of music within a sequence or build new sequences 
from segments of other sequences. You can also modify the 
data in a variety of ways using the commands in the Edit and 
Change menus. 

Select the Song Editor window by choosing it from the 
Windows menu, or by typing Command-2 on the Ilgs 
keyboard. 
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Like the sequencer window, the song editor is a table of tracks 
in which each track is listed on a separate row. But instead of 
alpha-numeric information, the Song Editor window provides 
a graphic representation of the musical data that the track 
contains, in one-measure blocks. 

The left border of the window is marked with the track 
numbers, and the top border is a measure ruler which marks 
off the measure numbers. Tracks containing MIDI data 
appear on the screen as a row of rectangular boxes, each box 
representing a measure. Solid black boxes contain MIDI data, 
while hollow boxes are measures of rests, without any MIDI 
data. 

The grey vertical bar at the end of the data area represents 
the end of the conductor track for the sequence. Even if the 
tracks you're looking at are completely empty of MIDI data, 
and no measure boxes are on the screen, the grey bar will still 
appear at the measure where the conductor track ends. 

scrolling You can scroll through the track data on the Song Editor 
through the window using the scroll bars. You can also scroll using the 
song editor method described for selecting blocks of measures in the 

window section on "Selecting measures to edit," below. 

playback paint Clicking anywhere in the Song Window with Auto OFF, will set 
the transport to start playing or recording from that paint. 

the 
measure 

ruler 

The row of numbers at the top of the Song Editor window is 
the measure ruler. It marks off measures in the sequence so 
that you can keep track of which part of the sequence you're 
looking at. You can change the numbering scheme displayed 
on the measure ruler by pressing one of the number keys 3-0 
across the top of the IIgs keyboard. If you press 3, every third 
measure on the ruler (1 ,3,6,9, and so on) IS numbered, while 
the rest of the measures are indicated by hash marks. If you 
press 4, every fourth measure is numbered, and so on. 
Pressing 0 numbers every tenth measure. The "+" key will 
increment your selection by one and the "-" key will change it 
back again. 

using 
song 

markers 

placing 
markers 

moving to 
a marker 

naming a 
marker 
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Master Tracks Jr. provides markers that let you identify a 
particular location in your sequence so that you can return to 
it any time you wish. Markers always mark the begrnnrng of a 
measure. Master Tracks Jr. markers look and act Irke tab 
stops in word processing programs and are useful for qUickly 
going to a desrred location in the Song Window. Markers are 
displayed at the top of the Song Editor window, I'ust below the 
window's title bar, on another honzontal bar cal ed the marker 
ruler. 

When the marker ruler is visible, you'll see asmall box at its . 
left edge containing a hollow upSide-down tnangle. ThiS box IS 
called the welf. To place a marker into the marker ruler, click 
and hold over the well. Another upside-down tnangle, the 
marker you'll be placing, will appear Just below the well. 

Now while still holding down the mouse button, drag the new 
marker to the measure where you want to place it. Once 
you've positioned the marker, release the mouse button. The 
marker will remain where you've placed It, and Will become 
solid black. In addition, a vertical dotted Irne Will appear below 
the marker extending through the track Irst to help you see 
exactly where the marked measure is in your track. You can 
move the marker any time you're in the Song Wrndow,. by 
clicking and holding on it, and dragging to ItS new location. 

To move the Song Editor to the next marker in the. ruler, press 
the Tab key on the Apple Ilgs keyboard. The data In the 
window will move so that the next marker IS at the extreme left 
of the window. Press the Tab key repeatedly until you reach 
the marker you wish. 

To move to a previous marker, press Shift-Tab. Again, the 
data lines up so that the marker IS at the left edge of the 
window. 

In a large composition, you may want to make a note to 
yourself to help you remember the musIc each marker IS 
pointing to. Master Tracks Jr. helps out by letting you name 
the markers on the screen. Once you've named a marker, the 
name appears to its immediate right on the marker ruler. 
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To name a marker or change its name, from the Song Editor 
window, you can double click on the marker to bring up a 
dialog box for the marker name. Type in the name from the 
IIgs keyboard, then click on OK or press Return to enter it and 
return to the Song Editor. 

editing The Song Editor lets you easily change MIDI data in large 
MIDI data regions uSlnil all the commands on both the Edit and Change 

menus. Again, the smallest unit available for editing changes 
In the Song Editor window IS an entire measure and all edits 

selecting 
measures 

to edit 

are done on multiples of whole measures. ' 

To make changes to one or more measures of your 
sequ9!1ce usmg menu commands, the region of measures 
must first be selecteci Selected measures appear on the 
screen highlighted In Inverse video. 

T~ select one ~r more adjacent measures in a single track, 
click over the first measure in the track, and drag over the 
entire group. 

4 

selecting an To select an entire track, click on the track number in the left 
entire track hand column. To select several adjacent entire tracks, click 

and hold over the first track number in the group, and drag 
the mouse up or down In the track number field. 

selecting 
measures 
across all 

. tracks 
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To select one measure in all tracks, click on the column for 
that measure in the measure ruler at the top of the window. 
To select adjacent measures in all tracks, click and hold on 
the column for the first measure in the group and drag to the 
column for the last measure. 

Song Editor 
y Refrain y Y(,l'"se 2 

4 8 12 16 20 1 ..] ___ .. ___ III8Ii _______ "lllliIlllll ____ 11 
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To deselect a selected area, simply click anywhere on the 
Song Editor window. 

2 

3 

4 

_lIIIBlllllIiIII_1 

selecting a There are two ways to select a block of measures across 
block of multiple tracks. First, you can position the mouse pointer at 

measures one corner of the block, click, and drag towards the diagonally 
opposite corner until the inverse highlight covers the 
measures you want to select. If all the measures you want to 
select aren't visible on the screen, you can scroll the screen 
simply by dragging to any edge of the window. The window 
Will scroll and the selection highlight will move with it. 

shift Click This technique can be used to scroll the Song Editor window, 
even If you don't want to select that particular block of 
measures. When you're through scrolling, simply click again, 
and the selected block will be unselected, 
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Second, a block can be defined by clicking at one corner of 
the block, holding down the shift key on the IIgs keyboard, 
and then clicking on the diagonally opposite corner. To define 
a block that is larger than one screen, you can scroll with the 
scroll bars after clicking on the first corner, but you must hold 
down the shift key before you click on the data area again. 

Note: If you plan to Cut, Copy, or Clear a region that includes 
notes that are tied from or to other measures, you should be 
sure you understand the way Master Tracks Jr. handles this 
situation. Read the section on tied notes in Chapter 7 for 
details. 

editing Once you have selected a measure or measures, you can 
the selected edit the region using the commands on the Edit or Change 

music menus. See Chapters 7 and 8 for instructions. 

erasing data Cutting a selected measure or a block of measures inside the 
from measures song window will remove data from those measures leaving 

them blank, and placing a ccpy of the data on the clipboard. 

erasing an Cutting an entire selected track (selected by clicking it's track 
entire track number) will remove it entirely, placing a ccpy of it on the 

clipboard. 

removing data 
and / or time 

from a 
sequence 

playing 
a sequence 

from the 
song editor 

scrolling during 
playback 

Cutting measures across all tracks (selected by clicking and / 
or dragging in the measure ruler) will remove that section 
from the sequence and remove those bars from the 
conductor track. 

Master Tracks Jr. lets you play your sequence no matter what 
window you're using, and the Song Editor window is no 
exception. Just click on the Transport's Play button or hit the 
spacebar to start playback. 

If the Song Window is selected as the Active Window, a 
vertical highlight bar moves along the track data to mark the 
measure that is currently playing. 

You can also use the Song Editor to determine at what pOint 
the song begins playing. This capability is useful when you 
want to hear just the part of the song you're working with, and 
you can also use it as an alternative to the fast forward and 
rewind buttons on the transport window. 

playback To use the Song Editor to determine the pOint at which play 
point begins, you must first turn the Transport window's Auto 

c:::I ............... .i ........ . ," I 
'.' ' .. 

Chapter 5-Song Editor WindOW 5-7 
control off. With Auto off, and the Song Editor Window active, 
click in the window at the place you want playback to begin. 
It's that simple. 



The File menu has a variety of commands that let you 
manage your sequence files. These commands work just as 
they do in most other Apple 119s applications, so if you've had 
any previous experience with the IIgs you'll already be 
familiar with how to use them. 

Open.,. !lO 

Close Inuention 1 
Save aes 
Save Rs ... 
Repert to Saued 

Import MID I file ..• 
EHport MIDI File . ., 

The File menu includes commands that allow you to read and 
write standard MIDI files. MIDI Files are an industry standard 
format for storing MIDI sequences. If you own any programs 
that support this new format, you will be able to share 
sequence files with these programs. You can save your 
sequence as a MIDI File (Export), or Import a MIDI File 
created with another program. 
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Master Tracks Jr. 
about 

sequence A Master Tracks Jr. file is a single sequence either in its 
temporary form in xour A~ple IIgs's memorY, or stored more 
permanently on a dlsk.A file IS open when you're working 
with It 10 your IIgs's active memory, whether you loaded it 
from disk or started a new sequence from scratch. When you 
close a file, it i8 removed fro,,:, memory, and you can only 
work on It agam by reloading It from the disk. 

fifes 

starting 
anew 

file 

opening 
an 

existing 
fife 

You can only have one sequence file open at a time in 
Master Tra~ks Jr .. If you're already working on a file, Master 
Trac~s Jr. gIves you a chance to save it when you create a 
new file or when you load a file from disk. 

Be sure to save your sequence files frequently while 
you work with them, so that you don't lose your work 
because of a power failure or other problems with your 
system. You can store files on any disk or drive in your 
system, as long as there is enough space, using options in 
the Save and Save As ... commands. 

To create a brand new sequence choose the New command 
on the File menu or press Comm'md-N on the Ilgs keyboard. 
Since you can only have one file open at a time, this 
c~mmand closes the file you've been working on, if any, 
giving you a chance to save it first if you like. 

When the new file .is opened, any l'Iindows you had open 
remain on screen In the same poSItion, but all the existing 
data disappears. Master Tracks Jr. calls the new file "Untitled" 
~ntil you :,ename it with a ":lame of y.our own ch.oice using the 
Save As command (the file name IS always displayed in the 

Transport window title bar). 

Choose the Open command or press Command-O on the 
IIgs keyboard when you want to load an existing disk file into 
Master Tracks Jr. for playback or further editing. When you 
choose the Open command, Master Tracks Jr. will first give 
you a chance to save the file you're currently working on, if 
any. 

Next, a dialog box will pop up, showing the name of the disk 
10 the currently selected drive at the upper right, and the 
names of all the Master Tracks Jr. files stored on that disk in a 
scrollable box at the left. If the list of files is too long to fit into 
this box, you can use the scroll bar at the right side to scroll 

closing 
a 

sequence 
file 

saving 
a 

sequence 
fife 
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through the list to the file you want. 

If the file you want is on a disk in another drive, click on Drive 
to select another drive. If you want a file on a disk that's. not 
currently in a drive, click on Eject, wait for the drive to eject the 
disk, and insert the disk you want. 

Once you've located the file you want to open, click over any 
portion of the name. The name Will now be highlighted, 
Indicating that it is selected. If you make a mistake, you can 
select a new file name just by clicking on it. When you've. 
selected the correct file, click on Open. The dialog box Will 
disappear, and Master Tracks Jr. will load the file. 

Another way to open the file is simply to double click on its 
name, either when it shows up in the dialog box while you are 
running Master Tracks Jr., orlrom the Apple Ilgs finder. If you 
do this from the finder, Master Tracks Jr. Will automatically be 
loaded (if it can be found on the available disks at the time), 
and your file will be opened for use. 

After the file is opened, the same set of windows you were 
using before you opened the file will still be on the screen, but 
the data in the windows will now be from the newly opened 
file. 

Use the Close command to end work on a particular file 
without leaving Master Tracks Jr .. When you choose the 
Close command, you'll be given an opportunity to save your 
current work if you've made any changes smce It was last 
saved. 

All windows you've been using remain on the screen, but they 
are now empty of data. Essentially, the Close command gives 
you another way of starting a new sequence. 

The Save command stores the sequence that's currently 
open on disk, if an earlier version of the file has already been 
saved. As soon as you choose the Save command or press 
CommandoS on the Ilgs keyboard, Master Tracks .Jr. will save 
the current version of the sequence 10 the same disk file, 
without any further action on your part, overwriting the 
existing file of the same name. 
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using the 
Save as ... 

command 

If your file has not been saved before, or if you haven't made 
any changes since the last time you saved it, the Save 
command IS disabled and appears in grey instead of black on 
the File menu. To save a file for the first time, or to resave a 
file that has already been saved, use the Save as ... command 
Instead. 

The Save As ... command lets you save a new file for the first 
time, or resave a file that has previously been saved, using a 
n~w name: If you WIS~: You r:nay also save your file on a 
different disk. In addition to ItS Importance for saving new files, 
this command IS especially useful when you want to store 
you~ latest edits as a different file to avoid erasing an earlier 
version of the sequence. 

When you choose the Save As ... command, a dialog box 
appears, which allows you to choose a name lor the file 
before you save it. The field where you enter the lile name is 
labeled "Save current Score as:." If you're saving a new file 
the program will supply the name "Untitled" in the file name 
field. If you're savI~g a previously saved file, the current name 
of the file appears In the file name field. 
If you want to change the name supplied by the program type 
In the new name. IfJoU leave the file name field highlighted. 
the name in the fiel will disappear as soon as you start to ' 
type In the new name. 

The Save As ... dialog box also lets you select the drive and 
disk w.here you want to store the new version of the file. At the 
nght Side of the box, you'll see the'name of the disk in the 
currently selected drive. Click on Eject to eject the disk. When 
the disk pops out, Insert the disk you want to use. Or click on 
Drrve to select another drive for the save operation. 
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If you decide you don't want to save the file after all, you can 
click on Cancel at any time. To go ahead and save the file with 
its new name, click on Save. After a few minutes, you'll be 
returned to the main Master Tracks Jr. screen. 

Choosing the Revert to Saved command loads the disk . 
version of the file that you're currently working on, restorrng 
the file to the way it was when you last saved it. Use this 
command when you've made changes in a sequence that 
you know you don't want to keep. 

When you choose the Revert to Saved command, Master 
Tracks Jr. pops up a dialog box asking you if you're sure that 
you want to discard the changes you've made since the last 
time you saved the file. If you want to go ahead with the . 
command, click on Yes, and the last saved version of the file 
will be loaded replacrng the data that was rn memory. To 
cancel the command, click on Cancel. 

MIDI Files are an industry standard format that has been 
adopted by many software and hardware manufacturers. 
This allows you to use Master Tracks Jr. to play or edit files 
created on other sequencers or to use your Master Tracks Jr. 
files with other sequencers or notation programs. Both types 
of MIDI Files are about 35% smaller than a normal Master 
Tracks Jr. file and thus take less room on your disk and less 
time to transmit by modem. 

Type 0 

Type 1 

All channels merged to a single multi~ 
channel track. 
Channel assignments saved 
Text and program change assignments 
fl.Q1 saved. 
Loop assignments and markers not 
saved. 

Parallel multiN channel tracks. 
Channel assignments saved. 
Text and program change assignments 
saved. 
Loop assignments and markers not 
saved. 
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quitting 
Master Tracks Jr. 

~:e~n ~~Ut~~I~~~~XPORT from the File menu, a dialog box 
IMPO~T from the F~I~f type 1 ortype O. When you select 
any MIDI files on curre~~7~ksMaster Tracks Jr. will display 
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Master Tracks Jr.'s Edit menu contains commands that are 
used within the Song Editor, Step Editor, or MIDI Data 
windows to edit MIDI data in selected measures or regions. 

Cut 
Copy 
Pns1~~ 

Clear 

MiH Ol~tn 
Insert Measure .. , 2e1 

Select All 
Show 

To use any of these commands on a specific region, the 
region must first be selected using the mouse as described in 
the. chapter on the Song Editor. If you want to use an Edit 
command on an entire sequence or track, you can skip that 

• step by using the File menu's special command, Select All. 
This.command selects the entire sequence at once if chosen 

. when the Song Editor is the active window. See the descrip-
. tion of the Select.AII command later in this chapter for details. 
The.Edit menu capabilities start with baSic Cut, Copy, Paste, 
and Undo editing commands. With Cut, Copy, and Paste, and 
a couple of supplemental commands, you can transfer data 
from any location in a sequence to any other location, or even 
toanpthersequence entirely. 
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working with 
tied notes 

about 
the 

clipboard 

the 
Undo 

command 

Before covering the Edit menu commands individually, there are a few things that you'll want to know about. 

There will probably be times when you'll want to select regions in the Song Editor window that include notes tied from the measure immediately before or after the selection. Master Tracks Jr. will recognize the tied notes when you use the Edit menu commands Cut, Copy, and Clear. 

When you use one of these commands, the program removes or copies only the portion of the note that falls within the measures in which the selected region is located. With the Cut and Copy commands, this portion of the note is moved to the clipboard, and appropriate note-<>n and note-<>ff events are added to it to make it a complete event. When you use Cut or Clear, the program also removes this portion of the note from the sequence, and inserts new note-<>n and note-<>ff events for the parts of the note that remain. 

The clipboard is the temporary storage location for MIDI data that Master Tracks uses when you move or copy within a sequence, or from one sequence to another. For faster performance, the Master Tracks Jr. clipboard is stored in RAM, the computer's internal memory, and not on disk like some Apple /lgs clipboard files. The effect of this is to speed up editing considerably. But there is a trade-<>ff. The problem with this approach is that the data in the clipboard will be lost if you lose power or the computer fails lor some other reason. Don't expect the clipboard file to be saved when you power down your computer. You must paste it into a sequence and save it using the File menu commands. 

At the top 01 the Edit menu is the Undo command, which can also be executed by pressing Command-Z on the IIgs keyboard. This command allows you to cancel the last alteration you made to your sequence with the commands on the Edit or Change menus. You may also Undo your most recent recording. Remember, though, that Undo only applies to the last change you made in the sequence. As soon as you use another Edit or Change command or start recording a new track, the change is now permanent and can no longer be removed with Undo. 

1:::* cutting data , from measures 
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copying 

Chapler 7-Using the Edit Menu 7-3 Use the Cut command to remove MIDI data Irom the region you've selected, and place It in the Master Tracks Jr. . . clipboard. You can execute the Cut command by chOOSing [t from the Edit menu, or by pressing Command-X on the /lgs keyboard. 

The exact way that data is removed by the Cut command depends on how you'Ve selected the data: 

1>1/ you've selected one or more entire tracks in the Song Editor window, the Cut command removes the" data entirely. 

1>1/ you've selected the entire sequence using the Select All command, or with the mouse in the Song Ed[tor window, Cut removes all data. 

I> If you select one or more adjacent measures across,all tracks in the sequence, the measures are completely removed and the remainder of the sequence [S shifted to the left to liII in the gap. 

I> II you select a region within a track or tracks, but not all tracks in the song, Cut removes the data but leaves the measures intact. In other words, the rest 01 the data [n the track(s) is not shifted to the left to f[11 In the gap. Th[s is done to preserve the Conductor template across all the tracks. After this sort of cut, you'll see hollow measure bars indicating empty measures [n the Song Editor window. 

Remember, a Cut command can be reversed with the Undo / command. 

The Copy command makes a copy 01 the data in the selected region and puts it in the Master Tracks Jr. clipboard. The existing data is not changed. In addition to select[ng the Copy command with the mouse, you can also execute [t by pressing Command-C on the /lgs keyboard. 
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pasting Paste places the contents 01 the clipboard into the sequence 
beginning at the location of the blinking cursor. You can 
choose the command with the mouse, or use Command-V 
from the IIgs keyboard. 

clearing 

If the clipboard contains data from more than one track, data 
from the lowest numbered track in the clipboard goes into the 
track marked by the cursor. Data in the clipboard from 
subsequent tracks are automatically inserted into the next 
tracks in order. 

To use Paste, first select an insert paint by placing the cursor 
at the beginning 01 the measure where you want to insert the 
dipboard data. Then select the command. The data you paste 
In. replaces any eXIsting data In the sequence. (To merge the 
Clipboard data with the eXisting data, use the Mix Data 
command.) 

You. can paste data into empty tracks anywhere you like. Just 
position the cursor at the measure location where you want 
the pasted data to start, and execute the command. 
Remember, too, that you can Paste Clipboard data lrom one 
sequence to an entirely different sequence if you wish. 

Clear works exactly like Cut, except that the data is removed 
without placing it in the clipboard. This gives you an 
alternative way to remove portions of your sequence. You 
may find it useful when you want to remove data from your 
sequence, but you don't want to erase the contents of the 
clipboard. 

To use the Clear command, choose it Irom the Edit menu 
after you've selected the region you want to clear. Alternately, 
you can Simply press the backspace key after selecting a 
region. 

mixing The Mix Data command works identically to the Paste 
data comll!and, except that the data in the Clipboard that you're 

Inserting In the sequence is merged with existing data already 
In the sequence. 
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To use the Mix Data command, first place the blinking cursor 
. to the left of the first measure in the block where you want to 

place the clipboard data. Then choose the M,x Data 
command from the Edit menu, or type Command-M on the 
IIgs keyboard. 

~ Only one track can be mixed at a time with another. So if 
you want to "bounce down" several tracks to a single 
track, you must do them one by one. 

inserting With the Insert Measure command, you can lengthen the 
measures sequence by adding empty measures within it. You might use 

this command to insert a new section Into the middle of a 
composition or to add a blank space or countdown to the 
beginning. 

You may insert measures in all the tracks in the seguence, or 
only a single track. The newly rnserted measures Will all have 
the same meter and tempo as the last measure prror to the 
inserted section. Use the Change Conductor command rn the 
Change menu to alter these timing settings. 
When you choose Insert Measure, or type Command-Ion the 
IIgs keyboard, a dialog box pops up on screen. Type In the 
number of measures you wish to insert, and If you Wish to 
affect all tracks or just a single track. Click on OK or press 
Return to confirm your entry. Click on Cancel to return Without 
inserting measures. 

Insert Measure 

Insert I' I meusure(s) before measure 14. 

@ RII tracks 

o Only on track l:!:J 
([ Ok II ( Cancel) 
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select 
all 

show/hide 
clipboard 

In the Song Editor window, place the cursor at the beginning of the measure before which you want to insert the new measure(s). After executing the command, the new measures will appear on the screen as hollow measure boxes, indicating they are empty of MIDI data, with the cursor posmoned at the beginning of the first measure in the inserted group. All the remaining measures in the sequence will have been pushed to the right and renumbered. 

For example, say you want to insert two measures beginning after the eighth measure in the sequence, and just before what's now the ninth measure. Place the cursor between the eighth and ninth measures and select the Insert Measure command. Once you've completed the insertion, the newly inserted measures will be measures nine and ten, while what was formerly measure nine will now be measure eleven. 
The Select All command lets you select the entire sequence for use with the editing commands. From the Song Editor window, just choose Select All from the Edit menu, or type Command-A on the JIgs keyboard. Any visible data becomes highlighted, indicating that it is selected. 

Show Clipboard pops up a small window which describes the current contents of Master Tracks Jr.'s clipboard. The window tells you which tracks and bars the data was copied from, how long the data lasts in bars (measures), beats, and clock ticks, and whether the data was cut or copied. 

Clipboard 
Data 'WdS eoPiE'd: 

From: Track 1 
Bar 4 Beat! Clock 0 

Thru: Track 2 
Bar 7 Beat 4 Clock 239 

The Clipboard window remains on screen until you close it, although it's likely to get buried under other screen windows. If you like, you can leave the clipboard window open on the screen. If it gets hidden behind other windows, however, you must either move or close them to see the clipboard window again, or choose Show Clipboard from the Edit menu. 
41·.···

·· .. •········· ! 
I.. "'" 

·tIl·····!··:·.···· I", , \ 
L~' , ' ,,, 

I 

Duration .. . 
Quantize .. . 
Transpose .. . 

As with Edit menu commands, you must first select a region before ou can use the Change commands. To select a regiOn,Yuse the mouse as described in the chapter on the Song Editor. 
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change Choosing the Duration ... command pops up a dialog box that duration allows you to alter the duration of each note in the region­how long it plays. 

II Change Ou.al;on II 

I @ Sel .11 vo'ue, to 1 Ji ~ ~ 0 Tup'el @J : [] 'It 
o Change to ~ % of current lJalues I 

,I 
"""OK 

11',1 " L........:.:.:. [ (:oncel 1 . 

The dialog box gives you two choices for changing note 
durations. 

The first option in the box lets you set all notes in the region to a specified duration. Activate this option by clicking in the circle next to it. A solid black dot appears within the circle when the option is selected. 

Next. select the duration you wish by using the arrow controls to choose the appropriate note duration icon. 

To select a tuplet resolution, click on the box next to "Tuplet," and enter the tuplet values you wish by clicking on the 
appropriate boxes and typing in the new numbers. 

Based on the duration you choose, the number of clock ticks 
~ach note will receive in the region appears in a box to the right of the arrow controls. If you prefer, you can type in any duration value, expressed In clock ticks, you wish into this box. 

The second option in the Change Duration dialog box allows 
you to scale all duration values in the selected region by a 
percenta~e of their current values. Again, click on the circle beside thiS option to select it, so that the solid black dot 
appears . .Now type in the percentage of the current duration 
values, within the range of 1 to 999%, you wish to use. With this option, the relative timing of all the notes is preserved. 

After selecting the option you wish, Click on OK or press Return to complete the command, or click on Cancel to return to your work without making any changes. 
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change 
velocity 
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The Dialog box that pops up when you choose the Velocity:" command lets you change the velocity values for all notes In 
a selected region. 

Change Uelocity 

@ On Uelocities 0 Off Velocities 

@Set all "eloeities to 0 
o Change to 0 % of current ualues 
o Change smoothly from ~ to ~ 
o R~d D to all values 

I OK I cancel) 

Changing velocity is useful for adding punches to a track or to miXthe loudness ofa track or passage relative to other 
tracks.lt can also be used to bring velocity values up or down over time to create swells, crescendos, and decrescendos. 

~ir~ltY9U need to decide whether ,Your changes will apply to nole'on velocities, note-off velOCities, or both. Click over the 
circle to tfIe right of one or both of these chOices In the dialog 
box, Most synths do not transmit or recognize note-off 
velocities. 

Next, you can deCide from among four options for altering the velocity values. Click over the Circle next to the option you 
select: 

1 . You can set all velocity values in the region to a specific 
value. 

2. You can change all velocity values by a specific 
percentage. 

3 You can have all velocity values in the region change 
. smoothly from one value at the beginning of the region 
to another value at the end of the region. 

4. You can add or subtract (with a minus value) a set 
amount to all velocity values in the region. 
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change 
conductor 

After selecti~g which of these four options you wish, click on 
the approprrate data box(es) for that option and type in the 
value or percentage you've chosen. Click on OK or press 
Return to enter the value. 

Valid MIDI velocity values are between 1 and 127 A velocity 
value of "0" is the same as a "note off" command. if you enter 
a velocity value below 1 or above 127 in options 1 or 3 above, 
Ma~ter Tracks Jr. will tell you that the value is out of range. 
You II then be returned to to the Change Velocity dialog box 
with a highlight on the invalid value. If the values you've 
entered In options 2 or 4 throw existing velocity values out of 
the valid range, Master Tracks Jr. will Clip them to 1 or 127 as 
approprrate. 

Master Tracks Jr. has a separate Conductor track with which 
you can determine the rhythmic structure of your entire 
sequence. All tracks in the sequence follow the settings in the 
Conductor track for meter, tempo, and the type of note that 
gets the beat, but you can vary these settings from measure 
to measure as often as you like. You can even change 
tempos gradually for ritardandos and accelerandos 
anywhere In your sequence. The vertical grey bar in the Song 
Editor Window represents the end of the Conductor track. ' 

Choose the Conductor ... command on the Change menu to 
brrng up the Change Conductor dialog box. Optionally, you 
can access the Change G~nductor dialog box from the 
Conductor Window by clicking on the time Signature in the 
wmdow. 

thonge Conductor 

from Meosure [Q to ~ 

o Set Meter to ~ and Beat to ~ 
@Set all Tempos to ~ 

o Change to 0 % of current values 

o Change smoothly from §] to [§] 
o Hdd 0 to all ualu~$ 
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~t~~~~i:~~~~~~!~~~ commands, you don't have to the Conductor command. If 
n01Ne',er, the first and last 

appear the appropriate boxes 

changing 
tempo 

tempo range 

You can define a new region by 
dift:en,nt measure numbers. 

to set the meter or beat note for the region, click 
next to that option in the dialog box. Then type in 

meter values. Select the note icon for the beat note 
, ,w'rth the arrow controls at the right. In 4/4 time, if a quarter 

note beat is selected, you will hear 4 beeps per measure 
from the metronome with an accent on each first beat and 
you will see four main divisions in each measure in the Step 
Edit Window. If you change the beat to an eighth note, you 
will now hear 8 beeps per measure and see 8 main diVisions 
per measure. Tempo will now be half speed since it is 
measured in "beats" per minute so you may wish to double 
the tempo for this region. 

You have four options for setting a new tempo in the region: 

1. You can set all tempo values in the region to a specific 
value. 

2. You can change all tempo values by a specific 
percentage. 

3. You can have all tempo values in the region change 
smoothly from one value at the beginning of the region 
to another value at the end of the region. 

4. You can add or subtract.(with a minus value) a set 
amount to all tempo values in the region. 

Afterselecting which of these four options you wish, click on 
the appropriate data box(es) for that option and type in the 
value or percentage you've chosen. The range of permissible 
values for tempo setting is 10 to 300 with beat set to quarter 
note, but with beat set to sixteenth note, tempos can be up to 
1200 BPM. If you enter a value outside this range with option 
1 or 3, Master Tracks Jr. will highlight the illegal value and ask 
you to change it before you can return to your work. Any 
existing tempo values changed by options 2 or 4 so that they 
are out of range will be truncated to the maximum or 
minimum values. 
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changing 
meter 

conductor 
template 

transpose 

Click on OK or press Retum to complete the Conductor 
command. Click on Cancel to exit the command without 
making any changes. 

The Conductor track allows you to have multiple meters in 
the same song. One way to use multiple meters is to create 
the rhythmic structure of your sequence with the Conductor 
track before you record any music. The Conductor track is 
equivalent to a "tempo map" and a "meter map" combined 
into a Single structure. Use the Conductor command to define 
meter and tempo for each section in turn. Once you've 
created this Conductor template, you can record your music, 
and the program will automatically shift meters at the correct 
measures as you record. 

To see how this process works, try this example: First, select 
New from the File menu to clear the IIgs's memory. Now 
choose the Conductor command from the Change menu. Set 
bars 1 to 4 to a 4/4 meter at 100 beats per minute with a 
quarter note beat. Now choose the Conductor command 
again, and set bars 5 to 8 to 3/4 at 140 beats per minute. 
Choose the command a third time, and set bars 9 to 12 to 214 
at 80 bpm. 

In the Song Editor window, you'll now see that you have a 12 
bar score. If you move the transport with the fast forward 
button, or "play" the empty sequence, you'll see the tempo 
and meter settings in the Conductor window change as you 
reach each new section of the Conductortrack. You can view 
the Conductor track graphically by pressing Command-O or 
choosing Conductor from the Windows menu. 

If you wish, you can save a Conductor track template as a 
disk file before you enter any music, and use it for as many 
separate sequences as you like. 

The Transpose command changes the pitch of all the notes 
in the selected region from one key to another. The 
Transpose command recognizes individual clock ticks, so 
you can use it on regions that include portions of measures. 

When you choose this command, Eo dialog box appears, and 
you are asked to enter the key from which you are transpos­
Ing,and the new key to which you want to transpose. 

a 
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quantize 

percentage 
ahead of 
the beat 
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Tronspose 

II 
[ Cancel i 

Transpose notes from §] to 0 

To enter these keys click on the appropriate box,. and then 
type in a pitch letter 'name, a # sign if you're entering an 
accidental and the octave number or play the appropriate 
note on your MIDI keyboard. Valid pitches range between 
C-2 and G8. You must enter all accidentals as sharps. 
Press Return or click on OK to enter the tran?posilion and 
return to your work. Click on Cancel to eXit without rnakmg 
any changes. 

The Quantize command aligns the start times of all.notes and 
other MIDI events in the selected re9,oo.to an Imagmary 
timing "grid." The grid divides the region mto Intervals of a set 
number of clock ticks. When you use the Quantize command, 
the command moves the start time of every. note within the 
region so that it falls precisely at the beginning of the nearest 
grid interval. You can choose to Quantize the entire note or 
just the attack times, leaving the note offs at their current 
locations. This could be used to create a more accurate 
rhythm while preserving release times of envelopes on 
synthesizers. 

Of course, you'll usually quantize to a grid based on a 
standard note type, such as to the closest quarter or 
sixteenth note. But Master Tracks Jr. gives you the freedom 
to quantize to any interval you wish. 

Master Tracks Jr.™ defaults to a Quantize setting of 35% 
ahead of the beat. In other words, if you are quantizing t~ 
16th note values, it will include (shift, align) any notes wohlCh 
fall from 35% before the current 16th note and up to 65 Yo 
behind the current 16th note. If a note falls more than 35% 
early, it will be quantized to the previous .16th note posilion. 
This range can be adjusted to your speCIfic situation by 
entering a different value in the percentage box. If you tend to 
rush a particular passage you may wish to set the range to 
include notes that fall a larger percentage ahead of the beat. 
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intensity The intensity (degree) of quantization is also adjustable. It has a default value of 100 %, meaning that notes will be quantized fully to the note or tick interval you specify. An intensity setting of 50% would move notes only half the distance to the nearest specified interval. 

slide notes 

using quantize 

Quantize 

o Entire note @Attacks only 

181 QUtmtize to ! .P 1m ~ 0 Tuplet @:]:r.o I 
Include notes up to ~ % ahead of the beat. 
Intensity §!] '7. 

o Slide notes @:=:J clocks to the 0 left @ right 

« Ok ; 

The Quantize command also allows you to shift start times in the quantized region slightly away from the grid interval. This feature is valuable for creating passages that are a little ahead of or behind the beat, sliding the notes in a track. 

Begin by choosing Quantize from the Change menu to bring up the Quantize dialog box. Then select the quantization value by using the arrow controls to choose the corresponding note duration icon. To select a tuplet resolution, click on the box next to "Tuplel." Then enter the tuplet values you wish by clicking on the appropriate boxes and typing in the numbers. 

Based on the duration you choose, the number of clock ticks in each note value will appear in a box to the right of the arrow controls. If you prefer, you can simply type in any duration value you wish In this box. If you wish to slide notes without quantizing them, click In the box next to the words "Quantize to", removing the "x" from il. 

CJ" ~" '1, , " ••.••.. 'M 
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offset for quantization, click on the box selleo.,,'''~.V~ so that an '>C' appears In the box. t .. ~ i;~··~~'~r'I~I~j~~~jrb~~~;~:~~~to slide notes befor~(left) or after and click on the CIrcle next to the number of clock ticks that you 
per quarter note) 

.' I ctions click on OK or press When you've e1t~re~~0C!~~~ti~e command. If you wish, yOU Returry to camp e 9
1 
to xt WIThout making any changes. can click. on Cance e I 



sequencer 

n~,fJ;~~:~~I~ access to any of the main 
._:,.:~. _.: ~ window is not currently on the 

other windows, you can bring 
the Windows menu in one of 

• You can choose the window you wish by name from 
the Windows menu 

• You can press a Command-key sequence on your 
IIgs keyboard. 

Here's a brief description of each of the main Master Tracks 
Jr. windows, including the Command-key sequence you can 
use to call up the window from the IIgs keyboard: 

~ Command-1 

The Sequencer window allows you to see and name all the 
tracks in your sequence. In addition, it lets you choose which 
tracks play, record, solo, and loop. You can also enter MIDI 
channel settings and initial MIDI program numbers for each 
track in the sequence. 
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song editor ~ Command-2 

The Song Editor window provides a graphic display of your 
sequence in units of measures, and shows you where the end 
of the sequence falls. Blocks of measures can be selected 
and edited with a variety of powerful commands. You can 
place and display markers that allow to quickly find specific 
places in your sequence. 

conductor The Conductor window shows the Tempo, Time Signature, 
and Beat for the current measure. A playback offset tempo is 
also displayed and can be adjusted with the scroll bar. 
Choose Conductor from the windows menu to bring it to the 
front.and make it active. 

transport The Transport window contains buttons for playback, record, 
and all operational controls for the sequencer, including Auto, 
Punch In, MIDI Thru, Metronome, Count In and Wait for MIDI 
Keypress. It also contains the counters. Choose Transport 
from the windows menu to bring it to the front and make it 
active. 

1.'."_'1'· ...... . .. ' 
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display 
memory 

use 

The ~oodies menu brings together many powerful and 
sophisticated features on a Single menu and includes many of 
Master Tracks Jr.'s unique features. 

!€R 

Selecting Mem~ry brings up a small window that shows how 
much memory, In bytes, that your score is using, how much 
memory IS being used by Master Tracks Jr.'s clipboard and 
how much memory is still. available. The memory window will 
r~maln on the screen until you close It, or caver it with another 
Window. Bnng It to the front by selecting Memory again. 

:0; Memory ~ 

Score Size:: 126K 
Clipboard Size:: 48K 
Fr!i'e Memory'" 324K 
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configuring your The MIDI Setup command lets you choose which Apple IIgs 
MIDI port setup port your MIDI interface is connected to, and whether Master 

Tracks Jr. uses its own internal clock for sync timing, or 
follows an external MIDI clock source. 

assigning MIDI 
data port 

using the 
internal 

interface 

selecting the 
timing source 

MIDI Setup 

Port: 
@Modem 
o Printer 
o Internol Cord 

in slot [II 

( OK ) 

Sync: 
@Internal 
OMIDI 

( Cancel ) 

Selecting the command brings up a dialog box that lets you 
make these choices. Once you've made your changes, click 
on OK to to enter them and return to the program, or click on 
Cancel to go back without saving your changes. 

Master Tracks Jr. allows you to use either the modem or 
printer port for your MIDI interface. You also have the option 
of using the standard Apple II internal interface. To do so, 
simply click on the appropriate circle on the left side of the 
MIDI Setup dialog box. A smaller solid black circle will appear 
within the circle when the selection is made. 

If you are using the internal interface you must also select 
which slot the card will reside in. You must also change the 
control panel of the IIgs to make use of this option. To enter 
the control panel, hold down the open apple(command) key, 
the control key and the escape key simultaneously. (See your 
IIgs manual for details.) Once in the control panel, go to the 
section called slots and make sure that the slot that your card 
is in indicates "Your Card". 
If you are using an external interface, make sure the control 
panel indicates "Modem Port" or "Printer Port" respectively. 

The timing of a Master Tracks Jr. sequence can be set by its 
own internal clock or by an external MIDI Clock. If you use an 
external MIDI source for timing, Master Tracks Jr. responds 
to all MIDI timing messages, including Start, Stop, Continue, 
Song Pointer, and MIDI clocks. 

recording 

selecting 
duration 

tuplets 
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Only one clock source can be active at a time. To set the sync 
source to the program's internal clock, click over the circle 
next to "Internal" on the right side of the MIDI Setup dialog 
box. If you want to sync the sequence to an external MIDI 
clOCk source, cliCk instead on the circle next to "MIDI". 

Only one port can be active to record and play back MIDI 
data. However, you can use the same port for MIDI sync 
information if you wish. If you're using the single port for both 
note data and sync information, be sure to select "MIDI" in the 
Setup dialog box. Chapter 11 goes into more detail about 
syncing to external sources. 

Some compositions contain passages which are extremely 
difficult or even impossible to play in real time. Master Tracks 
Jr. provides an easy way to enter these passages with it's 
Step Record feature. 

Choose Step Record irom the Goodies Menu to bring up the 
Step Record dialog box. You have a track enabled for Record 
in the Sequencer Window to enter the Step Record mode. 
That track number is displayed in the dialog box. 

When the Step Record Dialog box is on your screen, Master 
Tracks Jr. will record the pitch on any notes you play on your 
MIDI keyboard. You select the duration of these notes by 
clicking on the appropriate note icon from the row of note 
icons at the top of the Step Record dialog box. By holding the 
Shift key while you click on an icon you can add it to an 
already selected note value. The total clock value of your 
chosen duration appears to the right of the "~" sign. The clock 
value will change when you select or add different note values 
by clicking on them. 

You may also choose among three different articulations for 
your Step Entered passage, Stacatto, Normal, or Legato. 
This choice will also affect the clock value. 

Tuplet values can be chosen by clicking in the small square 
box next to the word "Tuplet' and then clicking in each field to 
the right to enter the appropriate value. 
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selecting 
recording 

location 

erasing 
mistakes 

rests 

MIDI channel 

Step Record 

[:] [B 110 0 [!I [!I 0 = 192 clocks 

I 05to&otto @ Normal a Legoto 110 TUPlet~: [3J I 

Tnack 3 

Chonnel 

[D 

II OK II 

lIIIII!!ZI But Clock 

I3IJ I I: 1:000 I [E] 
I Bock: Step I Rest I I Measure I 

Doto 
o 

( Cancel ) 

Step Recording can begin at any location. To move the 
Transport to your desired location click the appropriate 
arrows to move forward or backward in your sequence. The 
counter will move one measure, beat, or clock depending on 
which word above the counter is highlighted. To highlight 
measure, beat, or clock simply click on the word. 

There are three buttons below the counter display. The first 
one "Sack Step" lets you back over notes you may have 
played aCCidentally, erasing them. 

The second button, "Rest", will enter a rest of the selected 
note value when you click it. The third button, "measure", will 
enter a full measure of rest when clicked. 

Click in the box below the word "Channel' to enter the MIDi 
channel you wish to record on. 

MIDI data The Data indicator to the right of the Transport counter will 
indicator flash when incoming data is received. 

overdubbing You may add parts to an existing track ("Overdub") in Step 
Record mode at any time since notes entered in Step Record 

exiting 
step record 

using the 
record tilter 

changing 
record filter 

settings 
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are actually mixed in with existing data. To record over an 
existing track in Step Record mode, replacing the existing 
data, you must first erase the track in the Song Window. (See 
Chapter 5 for details) 

When you have completed "Stepping in" your recording click 
on "OK" to exit the Step Record dialog box. Click on "Cancel" 
to exit without keeping your recording. 

Master Tracks Jr. can selectively record only the MIDI data 
you wish, while it filters out any data that you don~ want to 
record. Choose the Record Filter command on the Goodies 
menu to bring up a dialog box that lets you choose which 
combination of MIDI data types Master Tracks Jr. will record. 

With this feature, you can independently select or disable 
each MIDI data type, including pitch bend, channel pressure 
(also known as monophonic key pressure or aftertouch), 
polyphonic key pressure, modulation, program changes, note 
data, and other MIDI controllers. You can also have the 
program quantize note timing while you are recording. 

As a simple example, you may want to conserve memory by 
flltenng out aftertouch or modulation wheel data (Since both 
of these controllers send data continuously, they can quickly 
fill up large amounts of your system memory). Filtering out the 
aftertouch and mod wheel data is a simple matter of 
deactivating these options on the Record Filter dialog box. 

You can choose not to record notes at all, so that you can 
create a separate track for, say, pitch bend data. That way, 
you can concentrate on making your pitch bends as accurate 
as possible. You can choose a single channel that Master 
Tracks Jr. will "listen to" while recording, while it ignores 
incoming data on other channels. You can also quantize on 
input as many drum machines do. 

To change the Record Filter settings, first choose Record 
Filter on the Goodies menu. In response, the Record Filter 
dialog box appears. 

Each MIDI data type appears in the dialog box with a 
corresponding box to the left of its name. When an "x" 
appears in the box, that data type will be recorded. When the 
box IS empty, that data type is disabled, and it will be ignored 
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miscellaneous 
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selecting 
individual 

channels on the 
record filter 

quantizing 
while 

recording 

during recording, You can select or disable any combination 
of data types you wish, Clicking on the boxes toggles them 
between the selected and disabled settings, 

Record Filter 

Select type of data to be recorded 

181 Notes 

121 Pitch Bend 

181 Channel Pressure 

t8I POlyphonic Key Pressure 

D Only on chonnel Iii] 

181 Controllen 
181 Modulation 

181 Program Chonge 

o QUantize to l'-Jl"~"-'§:]=O=-D-T-u-,,-.t-;=ID=;-''''ID=I 

Shift all notes up to @D '7.. tlhead of the beat. 

The Controllers option in the Record Filter dialog box refers to 
all miscellaneous MIDI controllers other than the ones 
specifically listed in the box, Most popular synthesizers 
respond at most to only a few of these miscellaneous 
controllers, and many don't recognize anything beyond pitch 
bend, modulation, and after touch, Consult your synthesizer 
owner's manual for the numbers of any controllers that your 
instrument can send or receive. 

Another choice on the Record Filter dialog box, "Only on 
Channel" allows you to filter out data from all but one MIDI 
channel when you record, When this setting is active, the box 
beside it contains an "x", You can deactivate this option by 
clicking on the box beside so that it is empty, and data from all 
channels will be recorded, 

If you wish to use this option, enter the channel number by 
clicking on the data box on the right of the option, and then 
typing in the channel number, from 1 to 16, 

You can use the option on the Record Filter labeled "Quantize 
to" to quantize notes while you record them, much as a drum 
machine does, Activate this option by clicking in the box next 
to it. An "x" appears in the box when it is active, 

exiting the 
record tilter 
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Next, select the resolution for quantization by using the arrow 
keys to choose the appropriate note duration icon, To 
quantize to a tuplet resolution, click on the box next to 
"Tuplet," and enter the tuplet values you wish by clicking on 
the value boxes and typing in the new numbers, You may 
also change the percentage value that determines how far 
ahead of the beat Master Tracks Jr. will reach to quantize a 
note, (see chap, 10 Quantize) 

When you're finished making your Record Filter selections, 
return to the main Master Tracks Jr. screen by clicking on OK. 
Any settings you make in the Record Filter can be saved 
using the Preferences command in the File menu. To return 
without entering the changes you made, click on Cancel. 



In this chapter you'll find information about how you can put 
Master Tracks Jr. to work on your most sophisticated musical 
chores, including looping, punch in recording, MIDI and 
SMPTE sync, and more. 

The program stores tempo, beat and meter values in a 
separate "Conductor Track" along with each measure in the 
score, providing an elegant way of setting up conductor 
"templates" of meter and tempo changes. These values are 
stored in the Conductor Track and control how the MIDI data 
is broken up into measures. Conductor templates can be 
saved to disk as a score for later use. The vertical grey bar in 
the Song Editor represents the end of the Conductor Track. 

The Conductor track can be utilized to remove measures or 
even a single beat from your sequence. For example, if you 
have a 4/4 measure in your piece (say measure 6) which you 
have decided need the last beat removed. Select measure 6 
and choose Conductor from the Change Menu. Change the 
meter of measure 6 from 4/4 to 1/4 time. Now when you 
return to the Song Editor Window you will see 4 measures 
occupying the space previously taken up by measure 6. In 
the Song Editor Window, Cut the last of these new measures 
(#9) by selecting it along the measure ruler at the top of the 
window. Selecting measures in this manner cuts time out of 
the sequence on all 64 tracks. You can now select the 3 
remaining 1/4 measures (#6 - #8) and choose Conductor 
once again from the Change Menu and rebar those three 
measures to 3/4 time making them one measure again. 
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looping Individual tracks can be looped during playback. This feature 

is especially useful with short repeating sections such as bass 
or drum parts. 

auto paste 

looping to the 
half bar 

Record the part once, and then edit if necessary. You can trim 
your loops using the Cut command to get the the proper 
number of measures to loop. A track ends where there. are nO 
more filled or hollow measures present In the Song Editor. For 
reference, the grey vertical bar in the Song Editor indicates 
the end of the conductor track. 
Turn on the track's loop control and let the part play back. Lay 
down other parts or even other loops against it by recording 
on other tracks. 

Remember that the loop is only stored in memory once, and. 
always starts at the beginning of the sequence. That means If 
you start playback past the point of the loop, the track will not 
playback. That also means if you are copying tracks from one 
sequence to another it may not be possible to preserve the 
loops that begin later in the piece .. This is the reason to create 
literal copies of your loops, especially before bUilding songs. 

Loops encourage speed and spontaneity in music making 
and also save memory. Use them to work out your Ideas. 
However, once your song or song section is com~lete, copy 
and paste the looped part into the track so that Itf!lIs out to the 
end of the sequence. This will give you the flexibility of Master 
Tracks Jr.'s song structure. Thiswill also I~t you create subtle 
variations in the loop each lime It plays uSing the Change 
menu or other regional editing commands. 

Once you have copied your looped part you can ~ppend as 
many copies of it as you like by repeatedly selecling Paste or 
pressing Command-V. The insert pOlnl automatically moves 
to the end of the last paste. 

Master Tracks Jr.'s Loop feature requires you to loop to the 
nearest measure bul if your phrase ends In the middle of a 
measure and you wantto loop it anyway, it can be accom­
plished by re-barring the last measure of Ihe track. Lei's say 
you're working in 414 lime bul you wanl the track to loop a two 
and a half bar phrase. Select bar 3 (presumably the last bar of 
the track) and choose Conductor from Ihe Change Menu. 
Click in the circle next to Set Meter and selthe meter to 1/4 
lime. You will now have 4 measures wilh one beat each in . 
them in the place of old measure #3 which had four beats In It. 
Seleclthe last two of Ihese new measures and Cut them. 
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Your Irack will now loop Ihe way you want ilia. 

Master Tracks Jr. provides up to 9999 measures by 64 tracks 
of literal track data in which to work provided you have 
enough memory in your computer. Variations and combina­
tions of two song building techniques give you many ways of 
building songs from segments withoul giving up the ability to 
edit or add additional tracks over the entire length of the song. 
Using these techniques make it possible to add variation and 
sweetening to repeating sections and help to keep your song 
organized In a single file. 

The first method separates songs into sections within the 
same long sequence. Build a conductor template and layout 
the song structure using markers. You can begin record or 
play at any point, so you can work on whatever section you 
like at any time. Leave several blank measures between 
sections to avoid aCCidentally erasing anything, and then, 
using the Cut command, remove the blank measures later 
when you've finished recording. You can copy and paste 
between sections at will and your file will save all sections at 
once. 

Another method lets you build songs in a more traditional way 
by appending different files together from the disk. For 
example, you could record three separate sequences and 
save them individually on the disk in separate files called 
Intro, Verse and Chorus. Open the verse and copy it. Then 
Open the Intra and paste the Verse onlo the end of it. Set 
markers if you wish and use Save as ... to save the new file. 
Call it Song. Open the Chorus file and copy it. Open the Song 
rile and paste the Chorus at the end of Ihe Verse. You will now 
have a large Song in memory based on Inlro, Verse and 
Chorus which you can add to and edit further.. This Song can 
also be used as part of another, longer, song. 

If you have enough memory in your IIgs, you can have Master 
Tracks Jr. accompany you (or entertain you) for a list of 
songs. Use Ihe method described above but replace "Intra, 
Verse, and Chorus" with actual songs. Insert a few blank bars 
between each song and place markers at the beginning and 
end of each song. The markers allow you to quickly TAB from 
song to song. To determine the time between songs, select 
the inserted blank bars and use the Conductor dialog box 
fram the Change menu to adjust the tempo in the blank 
measures . 
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sequence data 
structure 
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MIDI delay 
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Song Pointer 

Master Tracks Jr. stores sequences as groups of tracks and 
measures along with a separate conductor track. The 
conductor track determines how data is stored, displayed and 
played back based on the meter, beat and tempo values 
stored with each measure. Storing data in measures is not 
required for MIDI sequencing but becomes more important 
when you begin to provide sophisticated graphic editing 
operations as those found in Master Tracks Jr., and when you 
desire to convert your MIDI sequences to music notation 
(more about this later). 

Ties are a special case of MIDI data and may cause problems 
for you when you cut and paste across tied notes. Some MIDI 
events are single events such as Program Change #7 or 
Sustain Pedal On. Because notes have a certain duration 
between note on and note off and Master Tracks Jr. stores 
notes in 9roups of measures, notes that tie across measure 
"boundaries" are stored internally as notes tied to one 
another, just as you would with music notation. When you cut 
across ties (not usually recommended) the ties will 
automatically be clipped with note on or note off events added 
so that no notes hang in the sequence or on the clipboard. 

You can delay a track by individual ciock ticks (there are 48 
clock ticks per quarter note). 
To produce MIDI delay or even MIDI PRE- Delay use the 
offset feature in the Quantize Dialog Box from the Change 
Menu. You can experiment with different values for the 
number of clocks until you get something that does the job. If 
you wish to offset start times without quantizing, click in the 
quantize box to remove the "x" in it. 

MIDI delay can be used to "fatten up" a track's sound by 
playing two tracks together to separate channels slightly 
delayed. More radical delays or offsets can be achieved using 
the song editor to delay tracks by measures using cut and 
paste. Rounds or echoing effects can be easily done and 
undone until you have something you like. 

Master Tracks Jr. generates its own internal time base when 
sync is set to Internal in MIDI Setup using a resolution of 48 
dock ticks per quarter note. It will send out MIDI timing 
messages, including Song POinter, Start, Continue, MIDI 
clocks, and Stop corresponding to the Transport activity. For 
example, whenever you move the Transport to a new location 
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in the sequence, a corresponding MIDI Song Pointer 
message is sent out. 

If Sync is set to MIDI in the MIDI Setup, the program accepts 
the timebase reference from an external MIDI source and 
interpolates 48 clocks per quarter note based on the 
incoming MIDI clock rate. It will receive and autolocate to MIDI 
Song Pointer when in MIDI Sync mode. Using MIDI Sync 
mode with an external SMPTE-to-MIDI sync device such as 
Roland SBX-80, Fostex 4050, Garfield Master Beat, Cooper 
PPS-1 and others, you can sync Master Tracks Jr. to SMPTE. 
Connect the MIDI out of the external sync boxto the MIDI in of 
your Apple IIgs MIDI interface and connect the interface to 
either the Modem port or the Printer port. Select MIDI Setup 
from the Goodies Menu and configure the setup so it matches 
your interface connections. 

If you want to record while you are in external sync, you must 
use a MIDI merging device. To do this connect the MIDI 
output from the device that will be generating the sync signal 
to one of the inputs of the MIDI merger. Next, take the MIDI 
out from your MIDI controller and connect it to the other MIDI 
in of the merger. The MIDI merger will combine the two 
signals together and send that signal to its MIDI out. Connect 
the MIDI out of the merger to the MIDI in of the IIgs interface. 
You can now record new tracks while Master Tracks Jr. runs 
in sync with your SMPTE striped video or audio tape. If your 
external sync box supports MIDI Song Pointer, Master Tracks 
Jr. will "chase" the tape transport and start anywhere in the 
piece. 
When synced to MIDI or SMPTE, the Conductor Track 
becomes unnecessary since the Tempo map should be 
coming from the SMPTE to MIDI converter. When used in this 
application, leave the Conductor set to 4/4 bars with quarter 
note beats. 

Master Tracks Jr. has 64 tracks on which to record. Most 
people use only 16 to 30 of them most of the time. This leaves 
a lot of empty space that can be used for making notes about 
your work. Just scroll down to an unused area in the 
Sequencer Window, click in a Track Name field and jot down 
whatever you like, perhaps information about the patches 
used and the numbers of your drum machine patterns. 
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addin Controller data can be added to an existin~ track by recording 

control/e~ it onto a fresh track while listening to the original track. Use 
to a 'rock Thru assigned to the same Channel as the existing track to 

, hear the effect of the controller while you play. 
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Program Changes can also be recorded after the fact using 
the method described above. 

The memory window (selected from the Windows menu) 
tells you how much memory your score takes up, how much 
memory is being used by the clipboard and how much 
memory is available for more notes. You can clear the 
clipboard memory by copying or cutting a blank measure. 
This frees up additional memory for the score. 

For optimum performance of Master Tracks Jr., we 
recommend that you don't move the mouse while you are 
recording a track or while you have the MIDI thru (on the 
Transport window) enabled. If the mouse is moved while you 
are recording or "thruing", you may experience a loss of MIDI 
data or the loss of your thru capability. If this does happen, 
you can reset the thru by opening the thru dialog box and 
re-enabling it by hitting the "OK" with the mouse (or by 
pressing return). 
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SUMMARY OF KEYBOARD COMMANDS 

TRANSPORT COMMANDS 

Space Bar 
Enter Key 
Tab Key 
Shift-Tab 

Start and Stop Transport 
Record 
Move to next Marker 
Move to previous Marker 

GENERAL COMMANDS 

Backspace Clears selected area in Song Window. 
Numbers 3 - 0 Change measure ruler display values 

+, - Change numbering from odd to even 
display 

Command -1 
Command - 2 

Command - N 
Command-O 
Command - S 
Command-Q 

Command - Z 
Command - X 
Command - C 
Command - V 
Command - M 
Command -I 
Command -A 
Clear 

WINDOW COMMANDS 

Sequencer Window 
Song Editor Window 

FILE COMMANDS 

Start with new sequence 
Open sequence from disk 
Save current sequence to disk 
Quit Master Tracks Jr.™ 

EDIT COMMANDS 

Undo last edit or change operation 
Cut . 
Copy 
Paste 
Mix 
Insert measure 
Select All 
Cancels a dialog box 

GOODIES COMMANDS 

Command - R Record Filter 
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J MOST COMMONLY USED MIDI CONTROLLERSJ 

CONTROLLER #1 
CONTROLLER #2 
CONTROLLER #4 
CONTROLLER #5 
CONTROLLER #6 
CONTROLLER #7 
CONTROLLER #8 
CONTROLLER #10 
CONTROLLER #64 
CONTROLLER #65 
CONTROLLER #66 
CONTROLLER #67 
CONTROLLER #92 
CONTROLLER #93 
CONTROLLER #94 
CONTROLLER #95 
CONTROLLER #96 
CONTROLLER #97 
CONTROLLER #122 
CONTROLLER #123 
CONTROLLER #124 
CONTROLLER #125 
CONTROLLER #126 
CONTROLLER #127 

MODULATION WHEEL 
BREATH CONTROLLER 
FOOT MODULATION 
PORT AMENTO TIME 
DATA ENTRY SUDER 
MAIN VOLUME 
BALANCE 
PAN 
SUSTAIN (DAMPER PEDAL) 
PORTAMENTO 
SOSTENUTO (MIDDLE PEDAL) 
SOFTPEDAL 
TREMELO DEPTH 
CHORUS DEPTH 
CELESTE (DETUNE) DEPTH 
PHASER DEPTH 
DATA INCREMENT 
DATA DECREMENT 
LOCAL CONTROL (OFF.o. ON=127) 

ALL NOTES OFF 
OMNI MODE OFF 
OMNIMODEON 
MONO MODE ON 
POLY MODEON 




